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PART ONE: INTRODUCTION TO THE APA 

WHAT IS APA? 
 APA is not a government agency, a Swedish rock band, an oil cartel, a test ban treaty, a sexually 
transmitted disease, a sports drink, a hair gel, or a California spiritualist movement.  APA stands for 
“American Psychological Association.”  Outside the field of psychology, “APA” is shorthand for the writing 
style manual published by the APA: The Publication Manual of the American Psychological Association. 

What is a style manual and who needs one?    
Many academic disciplines and professional fields such as law, chemistry, computer science, languages 
and literature, and medicine have developed their own style manuals (The Bluebook, ACS, IEEE, MLA, and 
AMA, respectively) .  These manuals  support the unique research and writing methods of each discipline 
and profession.  Style manuals reduce misunderstandings by setting consistent guidelines recognized by 
readers all over the world. 

The American Psychological Association developed its manual to guide researchers, writers, and readers 
through a science-based method of inquiry.  It is intended to support the underlying principles of objectivity, 
transparency, ethics, and clarity.  Because the APA style has worked well, it has been adopted in other 
fields--notably education, business, and undergraduate nursing—that share similar research protocols. 

Why so many guides?  Why can’t everyone use the same one?   
The research and writing for one academic discipline may require a style that does not meet the needs of 
other disciplines or professions.  You can understand how a professor of French literature, for example, 
might require a set of stylistic guidelines different from those of a chemist or neurosurgeon. 

Saint Mary’s University has adopted the APA as the official style manual for its School of Graduate and 
Professional Studies.  (SMU medical students use the AMA.)   Use of the APA ensures that SMU students 
have a solid stylistic foundation for their academic and professional writing.  

What’s in the APA that I need to know? 
Along with other useful information, the manual contains the following essential sections: 

• The "Writing Clearly and Concisely” section (pp. 61-84) is an excellent guide to getting ideas 
across clearly, effectively, and objectively.   

• "Mechanics of Style” section (pp. 87-114) lays out the rules of punctuation, spelling, and 
capitalization, among other things, as they apply in your discipline.  No guesswork.   

• The "Crediting Sources" section (pp. 169-189) explains methods for documenting credible 
research sources in an academically ethical way. 

• The "Reference Examples" section (pp. 193-244) provides dozens of examples for listing sources 
on your reference page in such as way that readers can identify and retrieve them. 

• The index (pp. 259-272) helps you locate specific information in the manual. 
 
 

BASIC FORMAT OF AN APA PAPER 
Check to see if your program requires variations on APA style.  

 
ALIGNMENT 
Alignment is set at the left margin only for all text except title and title page.  (Level 1 headings are centered 
individually with the Center text command.)  Lines should be even on the left margin but ragged on the right 
margin, like the text on this page.  Indent the first line of a paragraph ½ inch (1 Tab). 
 
SPACING AFTER PUNCTUATION [4.01] 
In general, insert 1 space after every mark of punctuation,* but insert 2 spaces after punctuation that ends 
a sentence.  Exceptions:  No space inside quotation marks and parentheses. Note the following examples: 
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Byer advocated a “go-it-alone” position in the conflict.  
Cole introduced the proposal (as recommended) and took a vote. 

FONT (TYPEFACE)  [8.03]                      
The standard font for student papers at Saint Mary's University SGPP is Times New Roman size 12.  (The 
text you are reading now is 9-point Arial).  Do not use underlining or all capitals unless your instructor 
specifies these.  Use boldface for headings only.  Keep the font the same throughout the paper unless your 
instructor tells you otherwise.   
  
HEADINGS [3.02-3.03]  
Headings help both the reader and the writer follow the paper's organizational structure, and good writers 
use them.  APA headings are boldfaced and follow a simple pattern of 5 levels, as illustrated in the APA 
manual. 
 
INDENTS [8.03] 

Indent the first sentence of each paragraph ½ inch (one Tab space).  All other lines of the paragraph wrap 
to the left margin, as in this paragraph.   Indent blocked quotes (40 words or more) ½ inch on the left side 
only, including the first sentence. Do not indent the first line of the abstract. For reference page entries 
create hanging indents as explained in this booklet under "Using MS Word for APA."  See examples in  
APA  pp. 50-51. 
 
LINE SPACING [8.03] 
Double-space all lines in the paper, including references and blocked quotes, unless your instructor 
specifies otherwise.  The first line of each page (except title page) begins at the top margin.  Maintain one 
double space after headings and between paragraphs. 
 
Use the double-space setting of the word processor.  Do not double-space manually by pressing the Enter 
key twice between lines 
 
MARGINS [8.03] 
Set margin at 1 inch on all sides.  Many  word processors set the default margin at 1.25, so you may need 
to adjust the margins to 1 inch.   
 
PAGE NUMBERS  [8.03, p. 230] 
Count the title page as page 1 of the document. Place page numbers at the top right corner, ½ inch from 
the top (inside the header).  If your program requires a running head, place it  on each page, inside the 
header, ½ inch from the top edge .  Use the word processor's automatic settings rather than typing the 
page number and header on each page.  (For word processing instructions see  "Using MS Word for APA" 
section of this booklet.)  For an illustration of page numbers and running heads, see the sample papers in 
the APA manual, pp. 41-60.  
 
PAPER [5.01] 
Use 8-1/2” x 11” white paper.  All papers are word-processed, one side only. 
 
TITLE PAGE   
The title page in the APA manual is intended for the submission of a manuscript for publication and may 
not serve to identify college papers.  If your program has not provided a model for a title page, use the 
example provided in this  booklet. 

Does APA require a page number on the title page? [p. 41] 
Yes, the APA illustrates both a page number and running head inside the header of  the title page and 
on all subsequent pages.  Follow the example unless instructed otherwise by your program guidelines.  

 
 
 
 
 

For word processing instructions, see "Using Microsoft Word 2007 for 
APA Tasks" in this booklet. 

? 
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What to Include on a Title Page 
The APA manual describes a title page for a manuscript submitted for publication.  That style of title page is 
not necessarily appropriate for student papers.  If your program or your instructor give you a sample title 
page, use that.  Otherwise use the sample text provided below. 

• Double-space the text and center it horizontally using the word processor's Center text command. 

• Place the running head and the page number inside the header, ½ inch from the top edge of the 
paper.  

• Insert the header and page number automatically (see "Using Microsoft Word 2007 for APA" in 
this booklet). Do not type page numbers manually. 

• If  your program prefers no page number or header on the first page, leave them off; however, you 
should count the title page as the first page even if you don't print  the number on it. 

• Set margins and font (size and type) on the title page to match the rest of paper.  Do not use 
boldface, italics, or underline.  

 
 
 
 
 
 
 
 

 
 

  



4 ©The Writing Center, Saint Mary's University of Minnesota Schools of Graduate & Professional Programs 

PLAGIARISM [1.10, 6.01-602] 
 

Plagiarism is a very serious academic offence.  A few students plagiarize in an attempt to cut corners or to 
cover academic deficiencies.  Other students, unfortunately, plagiarize because they don't understand the 
concept of plagiarism and the methods for avoiding it.  In either case, students are held accountable for 
their actions, and the penalty could be as severe as dismissal from the institution.  Follow the rules of 
citation and documentation carefully, and make sure you understand what is meant by paraphrasing. 
 
In APA style, a citation consists of author’s last name and date of publication.  A full citation appears on the 
References page. 
 
Plagiarism is a very serious academic and ethical issue.  Most universities impose penalties on students or 
staff who plagiarize, whether the plagiarism is deliberate or inadvertent.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
For more tips on avoiding plagiarism, go to the Writing Center website at 

www.smumn.edu/tcwrite 
 
 

 
QUOTING AND PARAPHRASING [1.10, 6.03-6.10] 

See APA manuals for details. 
 
QUOTATIONS  [6.03, 6.05-6.09]  

A. How can I use direct quotes effectively? 

In a word, sparingly.  You could probably write a better paper if you didn’t use any.  Direct quotes can be 
problematic because  
 

• Text lifted from its original context  can be misunderstood  in the context you provide in your 
paper.  Sometimes the meaning or intent of the quote is changed by the new context. 

• Quoting provides no indication of how well, or even if, you understand the material you are 
quoting.  Overuse of quotes therefore can cause you to lose credibility with your readers.   

• Quoting, if not done very skillfully, can break up the flow of your writing.  Suddenly encountering 
another person’s writing style can be jarring to readers. 

 
If you do quote, have a good reason to do so: for example,  

 to discuss the way an author expressed his or her ideas, 
 to present  a controversial or disputed statement verbatim, 
 to convey precise technical data or directions, 

Avoiding Plagiarism 
 
Plagiarism is the presentation of someone else’s work as your own.  If you use 
another author’s words you must attribute the work to its original source (its 
author, composer, etc.).   
 

• If you borrow an idea from, or directly quote from, another person’s 
work, cite the source of that idea or quote.   

• Phrases borrowed word-for-word from another author must be placed 
in quotation marks and followed by the page number from the original 
source.  

• Cite a source even if you don’t quote directly from it. 
• Paraphrase with care.  Inadequate paraphrasing can be another form of 

plagiarism, even with documentation provided. 

http://www.smumn.edu/tcwrite
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 to produce a rhetorical effect  when  introducing or emphasizing a point. 

Remember:  
• Quoted text of fewer than 40 words must be enclosed in quotation marks and followed by the 

page number of the original text; 
• Quotations of 40 words or more must be blocked—fully indented ½ inch from the left margin but 

not enclosed by quotation marks; 
• If you use a blocked quote, always provide your own interpretation or other commentary along 

with it. 

B. Quotation of Fewer than 40 Words.  Keep within paragraph text. 

Phenix and Scott-Dunn (1991) stated, “There is clearly a need for a new kind of spelling 
instruction, one that raises students’ awareness about language and its patterns, and focuses 
on word construction rather than word memorization” (p. 26). 

 
 
 

Jones and Smith (1992) described “the social construction of word families as a powerful 
tool in spelling instruction” (p. 415).  

 
C. Quotation of 40 or More Words. Place in separate, indented ("Blocked") paragraph. 

Swicegood (1994) linked the use of portfolios with the Individual Education Plan (IEP) 
when he stated the following: 

Insight gained through informal, ecological approaches gives teachers access to 
viable information, which in turn leads to more effective interventions and practices, 
both in schools and clinical settings.  The use of student portfolios in placement and 
instructional planning contexts, including the design of IEP goals and objectives, can 
add depth and breadth to the intervention process. (p. 14) 

 
 
 
 

D. Capitalization of Quotations* 
1. Capitalize the first word of a quoted sentence [p. 118, Quotation 1; and p. 293]. 

 
Harris (2000) remarked, “Finding information is an art, not a science” (p. 214). 

 According to Plotnik (1982), “The licensing or copyright agreement with the author 
does not cover items the author borrowed from another source” (p. 16). 

 
2. However, if the quoted sentence completes an unfinished sentence or follows the word that, 

do not capitalize the first word or precede it with a comma.  [p. 118, Quotation 2; and p. 120] 
 

Sutter was fascinated with Lake Superior because “the ore boats and foreign freighters 
seemed impossibly exotic” (p. 2).  
 
Quincy acknowledged that “negotiations over bride price sometimes involved more than 
the price of the bride” (p. 105). 

 
3. Do not capitalize the first word of a quoted phrase (incomplete sentence). 

 
Bryson (2002) called the English language “a merry confusion of quirks and 
irregularities that often seem willfully at odds with logic and common sense.” 
 

Note that indentation of quote replaces quotation marks and that the period 
is placed at end of quote rather than after the parenthesis of page citation. 

Note page number outside  quotation marks and period after parentheses. 
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4.  If the quote is interrupted, do not capitalize the first word of the resumed quote. 
  

“People and places,” noted Zinsser, “are the twin pillars on which most nonfiction is 
built” (p. 54). 

  * Sources:  Hacker, D. (2003) A writer’s reference, p. 284. Boston: Bedford St. Martins. 
Harris, M. (2000). Prentice Hall reference guide to grammar and usage (4th ed.), p. 229. Upper Saddle River, NJ: 
Prentice Hall. 

 

How should I format quoted material that is not in APA style? 

Section 3.35 (p. 118) of the APA manual states that direct quotations must adhere to the wording, spelling, 
and interior punctuation of the original source.  But what about formatting—for example, of bullets?  
According to a member of the APA Style Expert staff,  

This is a question about which there does not seem to be complete agreement 
 . . .  in the ranks. However, in my opinion, when quoting material, . . . keeping bullets rather than 
changing them to enumerated paragraphs is the way to go. The author undoubtedly had a choice 
between bullets and enumerated paragraphs when writing the original work, so it is good form to 
respect that choice when quoting the work, if it is possible to do so.  (Personal communication, 
November 7, 2002) 

 
To indent blocked quotes see section entitled "Using Microsoft Word for APA Tasks" in this booklet 
 

PARAPHRASES 

Perhaps paraphrasing is best defined by what it is not.  Changing or omitting a few words of another 
author’s statements in order to avoid a direct quote is not paraphrasing; it is, to be blunt, a form of 
plagiarism.  Readers are led to believe that you are presenting your understanding of another author’s 
words, when in fact you are using that author’s actual words (mostly).  Paraphrasing requires that you 
express ideas in your own terms.  Of course, you will use some of the same terminology as the original 
author.  If you are writing about corporate downsizing, for example, you can’t avoid that term. However, if 
you simply parrot the original author’s sentence structure, style, and diction, then you are not paraphrasing.   
 
Here’s a strategy for paraphrasing:  Read a section of the text you plan to reference, put the text aside, and 
write your own interpretation in your own words.  If you can’t do it, you need to reread the text for better 
understanding before you try again.  Sometimes reading aloud is helpful. 
 
Following are  examples of how to paraphrase, and how not to paraphrase. 
 
The Original  (Source:  Quincy, K. (1995). Hmong: History of a people. Cheney, WA: Eastern 

Washington University Press) 
 
Vietnamese tradition wisely forbade the confiscation of land for the payment of debts, but the 
French ignored this tradition.  A peasant's land was treated like any other real asset that could be 
seized for the payment of debts.  Fearing the confiscation of their land for non-payment of taxes, 
many peasants turned to wealthy Vietnamese for loans (at interest rates that often exceeded 
100% per annum) to meet their tax obligation in a futile attempt to stall off the inevitable.  
Slowly but surely Vietnam was transformed into a land of huge estates on which approximately 
seventy percent of the population toiled as sharecroppers.  French tax policy was exploitative 
and shortsighted.  Within two generations it created the social and economic conditions for 
revolution. (p. 114) 
In the following paragraph an attempt has been made to paraphrase the paragraph.  The phrases in 
boldface are identical to those in the original

?  
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Poor Paraphrase 

Vietnamese tradition did not allow the seizing of land for the payment of debts.  The 
French, however ignored the tradition and treated land like any other asset.  Fearing the 
loss of their property, many peasants went to wealthy Vietnamese for loans at high interest 
rates.  Eventually, Vietnam was changed into a collection of huge estates, where nearly 
three-fourths of the people worked as sharecroppers.  The tax policy of the French was 
unfair and misguided, and it set the stage for revolution (Quincy, 1995). 
 
Most of this unacceptable "paraphrase" consists of identical words in the identical grammatical form of the 
original.  Even if the paraphraser were to find synonyms for the original words, the passage would still be a 
plagiarism because the pattern of expression is the same.  Now compare the paragraph above to an 
acceptable paraphrase below, in which the ideas are summarized and expressed in a new way. 
 
 
Paraphrase (one possibility) 

Quincy (1995) described how destitute Vietnamese peasants had to sell off their small 
landholdings to pay for heavy taxes imposed by the French.  Wealthy Vietnamese then bought 
the small plots and consolidated them into large estates on which the peasants had to work as 
sharecroppers.  It was the "exploitative and shortsighted" French tax policies, Quincy concluded, 
that planted the seeds of political and social upheaval in Vietnam (p. 114).  
 
If you believe that some of the author's key words ought to be retained (in this example, his words 
describing French tax policy), then quote only those words in your paraphrase; but provide a page number 
for the quoted words.  If quoted words are included, the author's name should precede them 
 
 

THE BASICS OF CITING SOURCES 
 

What Is a Scholarly Source?  
Sources consulted for scholarly papers generally . . .   

• have been reviewed by professional experts (peers, juries) in the field of study,  
• contain content regarded as scholarly by professionals in the field, 
• are archived (stored for availability) for a significant length of time. 

The best way to limit your research to scholarly sources is to rely on professional or university databases, 
indexes, and catalogues.  On the Internet, for example, search engines like Yahoo, Google, or Lycos yield 
a range of sources, from scholarly to downright silly.  Aggregate databases such as ProQuest, Psych Info, 
or EBSCO allow you to limit your searches to scholarly sources that are adequately documented.   

Ask a librarian to help you limit your searches to scholarly sources.  

Why Do We Cite Sources 
 Why are we asked to use and cite scholarly sources in academic writing?  There are three 
reasons, and understanding these help us determine what sources to cite and how to document them.  

Reason 1: Academic Ethics. Honesty and fairness require us to let readers know whose ideas or words 
we have borrowed. We can’t pass off someone else’s work as our own. Simply changing a few words to 
avoid a direct quote doesn’t remove our obligation to identify the source. No matter how we word it, 
someone else’s idea still needs to be identified.   

Reason 2: Scholarly Credibility. Even new research needs to be founded on, or related to, existing 
scholarly work.  We must establish credibility and provide context for our ideas, indicating our 
knowledge about the topic. We need to relate our ideas to what has been written before by experts in 
the field. Citations help identify those experts.   

Reason 3:  Source Retrieval.  For various reasons, readers may want to view the sources we used in 
our writing, whether we used those sources for background or quoted them directly.  Our responsibility 
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as writers is to provide sufficient documentation in a systematic way so that readers can retrieve the 
information we used.   
  

 
Sources are Cited in Two Places: 

1. Cite in your text, by author’s last name and year (in parentheses).  The purpose of the in-text citation 
is to lead readers to the full citation on the reference page at the end of the document. 

2.  Cite on the reference page at the end of your document, where you will provide a full citation (see 
"Sample Reference Page").  The citations are listed in alphabetical order by author’s last name. 

 
 
FOUR ELEMENTS OF A REFERENCE PAGE ENTRY [6.27-6.31] 
 
APA is easier to learn when you recognize patterns of rules.  One of those patterns is that reference page 
entries contains four elements: 

 
• Each entry on an APA reference list comprises four elements that identify the source for easy 

retrieval:   

1. Author  2. Publication date  3. Title  4. Publisher information  

    In the following reference list entry, the four elements are illustrated with shading: 

 

 
 

Each element ends with a period, not a comma (though commas and other punctuation marks may 
appear within an element).  In the case of the Author element, the period after the author's initial serves 
as the final period for the element. 

  
• The fourth element, Publisher Information, varies according type of source.  But, again, patterns 

are important. 

• For Books, the publisher information contains: City, State, and Name of Publisher 

  Example  Thousand Oaks, CA: Jossey-Bass.  
 
• For Periodicals, the publisher information contains: Title of Journal, volume number(issue  

 number), page number range, and DOI number (if available). 

  Example  Journalism, 9(3), 285-308. doi:10.1177/1464884907089009 
 
• For Internet Sources, publisher information contains the URL (Internet address) 

 Example  Retrieved from http://www.census.gov/hhes/ 

--Do not place period after a URL. 
--Give the retrieval date only if there is no publication date or if the information is 

likely to disappear from the site:   

Example  Retrieved May 2, 2008, from http://www.dot.state.mn.us//appeals.pdf 

• For Electronic databases the publisher information is the same as a print source.  Do not give 
either a URL or the database name.  But if the database provides a DOI number, give that at the 
end of the reference after the period as follows: 

Example   Communication, 29(2), 198-216. doi:10.1177/1075547007308599 
 

 
 
  

Weissberg, R. (2007).  Oh to be rid of administrative wimps! Academic Questions, 26(2), 146-149.  

1 2 3 4 
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REFERENCE PAGE ENTRIES [pp. 184-224] 
 
 

 
 
 
 
The reference list always begins on a new page.  It contains an entry for each source cited in the paper, 
and only sources cited in the paper, listed in alphabetical order by author’s last name.  (The only exception 
is any personal communication of the writer, which is cited in the text but not in the reference list because it 
is not a retrievable source.)  Entries are double-spaced within entries and between entries.  Each entry is 
formatted in hanging indent (see instructions in the “MS Word for APA Tasks” section of this booklet). 
 
You will encounter an endless variety of sources and countless variations in types of sources.  The only 
way to ensure accuracy is to refer frequently to the APA manual [Chapter 4], where you will find excellent 
illustrations of APA style, including a complete reference page.  Also see the model paper [Figure 5.1] in 
the APA manual.   
 

PRINT SOURCE EXAMPLES  

Book 
 
 
 
 
 

 
Italicize the book title, but capitalize only the first word, proper nouns, and first word following a colon.  
Citations always end with a period unless the last element is an Internet address or DOI. 

 
Book, Publisher as Author 
 
 
 
 

 
Spell out the publisher's name in the author 's position.   Substitute the word Author for the publisher’s 
name 
 
Book, Chapter in a book   [p. 204] 

EXAMPLE 1: Unedited Book 
 

 

 

 
In-Text Citation: Cite author and pub year, and page numbers if necessary. 

 
EXAMPLE 2: Edited Book 

 If the book is edited, note editor’s name in the reference list entry (but not in the text) as follows:   

  

The examples in this booklet are set at 1.5 line spacing, and reduced sans serif type to 
conserve space, but the  APA calls for double-spacing and 12 pt. serif font throughout the 
text.  Use Times New Roman 12 pt. font. 

Lazear, D. G. (1994). Multiple intelligence approaches to assessment: Solving the assessment 

conundrum. Tucson, AZ: Zephyr Press. 

 

American Psychological Association. (1994). Publication manual of the American 

Psychological Association (5th ed.). Washington, DC: Author. 

 

Author, X. (pub year). Title of chapter. In Title of book (pp. xxx-xxx).  Pub location: 

Pub name. 
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• If the book and chapter authors are the same, but the chapter doesn’t have a separate title, 

then give a regular book citation, but include appropriate page numbers. 

• If the book author and chapter author are different, but the book is not edited, check to see if 
you are reading a secondary source. 

What if I cite material from several chapters of the same book by the same author? 

If all the chapters were written by the same author(s), then cite the book only once in the reference 
list without naming the separate chapters. 

Periodical Article with Two Authors 

 

 

 
Place an ampersand (&) before last author name.  Do not italicize or capitalize the title of the article.  
Journal title both italicized and capitalized.  After the title and a comma, type the volume number in 
italics.  Type issue number next to the volume number, without a space, enclose it parentheses, like 
this: Language Arts Teacher, 23(6), 47-58. 

 
Legal Documents 

Reference entries for legal documents are explained in the appendix to Chapter 7, pp. 216-
224, of the APA manual.  

 

 
ELECTRONIC SOURCES  [6.31-6.32, 7.01-7.02] 
 
A.  The Basics of Electronic Source Documentation 

• Minimum Information for a Source from the INTERNET 

Give the author, of course, if available, but you must provide at least  

1. Author (If no author given, place title in author position in reference.) 
2. Document title (If no author given, place title in author position in reference.)  
3. Publication date—or the notation (n. d.) if date not available 
4. The Uniform Resource Locator (URL—also called an Internet address)  

(Give the retrieval date only for an "unstable" source—one you think likely to be removed soon. 

Example 

 

 

 

 

 

Do not hyphenate a URL to force a break at the end of a line. It is not necessary to break a URL to 
avoid white space.  However, if you do break a URL, do so only after a slash or before a period.  Do 
not use a period to close an entry ending  with a URL. 
 
 

Crow, J., Verte, D., & Zinn, P. (2008, March 7). An older population and its housing needs: 

What are our options? Maturing & Health, 3, 122-126. Retrieved from 

http://oregon.agingcouncil.org/art.03.7.maturinghealth/oac.html 

 

Author, X. (pub year). Title of chapter.  In Name & Name (Eds.) Title of book (pp. xxx-

xxx). Pub location: Pub name. 

 

O’Flahaven, J. F., & Blassberg, R. (1992). Toward an embedded model of spelling 

instruction for emergent literates. Language Arts, 69(6), 409-417. 
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• Minimum Information for a Source from an ELECTRONIC DATABASE 

1. Author (If no author given, place title in author position in reference.) 
2. Publication date—or the notation (n. d.) if date not available 
3. Title (If not available, give a description of the work in parentheses) 
4. Publisher (If source is a journal, the publisher information is (a) journal name, (b) volume, (c) 

issue, (d) page range—all formatted in APA style. (Give DOI number, if provided, after the 
reference).  See also frequently cited business references under the "More Reference Entry 
Examples" in this booklet. 

Example 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

B.  Examples of Electronic Source Documentation   
A wide variation in electronic sources exists.  Newsletters, abstracts, reports, and other documents and 
forms of discourse are documented differently.  You will need to refer to the APA 5th edition for these. 

 
Journal Article from the  Internet 

 

 

 
 
 
Note: Use "Available from" rather than "Retrieved from" when the URL takes readers to a page that 
provides access to the document rather than the document itself. 

 
Journal Article from an Electronic Database 

 

 

 

  

? 

Mollica, R. F., Wyshak, G, & Lavelle, J. (1987). The psychosocial impact of war trauma and 

torture on Southeast Asian refugees. The American Journal of Psychology, 144(12), 

1267-1572. Available from http://ajp.psychiatryonline.org/cgi/reprint/144/12/1567 

 

Chan, B., Ray, P., & Parameswaran, N. (2008). Mobile e-health monitoring: An agent-based 

approach. IET Communications, 2(2), 223-230. doi: 10.1049/iet-com:20060646 

 

Weissberg, R. (2007). Oh to be rid of administrative wimps! Academic Questions, 20(2), 

146-149. doi: 10.1007/s12129-007-9006-x 

 

WHAT IS A DOI NUMBER ? [6.31-6.32, 7.01] 

DOI  is an abbreviation for Digital Object Identifier, a unique set of characters  assigned 
to identify an intellectual property resource so that it is searchable on the Internet.  
(When abbreviated on a reference page, the letters appear in lowercase, as shown in the 
example above.)    
 
The APA manual gives a complete explanation of the DOI, along with examples for its use 
in references, in the section numbers indicated above. 
 
For instructions on locating DOIs in Saint Mary's electronic databases, and for examples 
of how to use them, go to the free download of the Writing Center's Writing APA  
References for Electronic Sources 2007  at our website www.smumn.edu/tcwrite u nder 
the menu item "APA for Graduate Students." 
 

? 

http://web.ebscohost.com/ehost/viewarticle?data=dGJyMPPp44rp2%2fdV0%2bnjisfk5Ie46bZRt6yzTbKk63nn5Kx95uXxjL6rrUmupbBIrq6eTriqtVKzrJ5oy5zyit%2fk8Xnh6ueH7N%2fiVbCmt063qrZQrqqkhN%2fk5VXj5KR84LPpfeac8nnls79mpNfsVbCtslC1qLBQpNztiuvX8lXk6%2bqE8tv2jAAA&hid=16
http://www2.smumn.edu/deptpages/tcwritingcenter/content/writing/apa/APA_ELECTRONIC.pdf
http://www2.smumn.edu/deptpages/tcwritingcenter/content/writing/apa/APA_ELECTRONIC.pdf
http://www.smumn.edu/tcwrite
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ERIC Online Resources [p. 121, #62]  
ERIC (Educational Resources Information Center) contains mostly citations and abstracts, not full text 
documents.  If you want the full document,  you can order it from ERIC or use the location information to 
retrieve it yourself (with help from a librarian).    

 
 A reference page entry for an ERIC document you retrieved yourself should contain the ED 

number or EJ number assigned by ERIC, and ERIC should be identified (see APA p. 212, 
example 62).  For example,  

 
 
 
 
 
 
 
 
 An ERIC resource ordered through ERIC or through a librarian should be cited like any other 

source of its type, without mention of ERIC (because you found the citation in ERIC but not the 
document). 

 
MORE REFERENCE ENTRY EXAMPLES 
 
• Business and Management Online References 

Business and financial reports from online databases often differ significantly from other kinds of 
electronic sources.  Because the reports are updated frequently, the retrieval date is usually a 
necessary part of the reference.  Sometimes the database name is required to help the reader locate 
the information.  A few examples are provided here.  More information is available at the Writing 
Center's Web site: www.smumn.edu/tcwrite 

• Gale Virtual Reference Library 
Use the citation provided by Gale, but format  as closely as possible to APA style.  Retain Gale as part 
of the publisher information.  For example, compare the following citation provided by Gale to the APA 
reference that follows it: 

United Airlines Corp.. Mark Lane, Susan Salter, and Kevin Teague. Encyclopedia of 
Major Marketing Campaigns. Vol. 2. Detroit: Gale, 2007. p1695-1704. 

 
 

 
 

 
 
 
 

• EDGAR Database of Online Corporate Financial Information 
EDGAR is a public electronic database of forms filed with the U.S. Securities and Exchange 
Commission.  The source of the information is provided by the companies that file the forms.  

 
 
 
 
 
 
 Title of the document is the form number 
 URL takes readers to the EDGAR company search page, hence "available from." 
 In text citation:  Best Buy (2009) or (Best Buy, 2009) 

 

Miller, D. C., Sen, A., Malley, L. B., & Burns, S. D. (2009). Comparative indicators of 

education in the United States and other G-8 countries: 2009. Retrieved from ERIC 

database. (ED504634) 

 

Lane, M., Salter, S., & Teague, K. (2007). United Airlines Corp.  In Encyclopedia of major 

marketing campaigns (Vol. 2, pp. 1695-1704).  Retrieved from Gale Virtual 

Reference Library. 

 

Best Buy. (2009, June 29). 11-K. Available from EDGAR Company Search: 

http://www.sec.gov/edgar/searchedgar/companysearch.html 

http://www.smumn.edu/tcwrite
http://www.sec.gov/edgar.shtml
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• Datamonitor Online  
Datamonitor is accessed through Business Source Premier database.  Datamonitor is the author of its 
own reports. 

 

  Datamonitor (2009) or (Datamonitor, 2009) 
 
 
 
 
 
• Audiovisual Materials 

• Motion picture 

 

 

 

In-text citation:  Anderson and Baumbach (2005) or  (Anderson & Baumbach, 2005) 
 

• Video (DVD))  
 

 
 
 
 
 

In-text citation:  Haynes and Torres (2004) or  (Haynes &Torres, 2004)  
 

• Map retrieved online 

 
 
 
 
 
 

In-text citation:   

If the map information is only referred to in the text, cite as Central Intelligence Agency (2009) 
or (Central Intelligence Agency, 2009). 

If the map is reproduced in your text as a figure, follow directions under "Tables and Figures" in this 
booklet.  Place the reference information after the caption under the figure.  If the source is not cited 
elsewhere in the paper, you do not have to place an entry on the reference page.  

  

Datamonitor. (2009, May). Health care equipment & supplies in the United States: Industry 

profile (Reference code 0072-2077). Available from Business Source Premier 

database. 

Anderson, W. (Producer), & Baumbach, D. (2005). The squid and the whale [Motion 

picture]. U.S.: Samuel Goldwyn Films. 

 

Haynes, H. (Producer), & Torres, A. P. (Director). (2004). National Geographic—Wetback: 

The undocumented documentary [DVD].  U.S.: National Geographic. 

Central Intelligence Agency. (Cartographer). (2009, July 2). South Asia: Pakistan.  In 

Retrieved from https://www.cia.gov/library/publications/the-world-

factbook/geos/pk.html 
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PRIMARY & SECONDARY SOURCES [6.17] 
How and When to Cite 
 
The examples below were excerpted  from an article by Brophy (2006).  Selected text from Brophy was 
enlarged for illustration,  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
. 
 
In the illustration above, Brophy, the author of the article is the secondary source (the source you read). 
Nijstad, Deihl, and Stroebe are the primary source (the source you didn't read), cited by Brophy.  Primary 
means the first source of information.  Secondary is the source in which the primary source was cited. 
Brophy is  telling readers what the Nijstad, Deihl, and Stroebe said and did. 
 

In-Text Citation 

Cite both authors, making clear who cited whom.  Using the example above, you would cite this way:  
"Nijstad, Diehl, and Stroebe (as cited in Brophy, 2006) asserted that . . .."  Such an arrangement 
tells the reader who is being cited (Nijstad, Diehl, & Stroebe) and where you their information (in in 
Brophy).  If your readers want to view the primary text (by Nijstad, Diehl, & Stroebe), they must go to 
Brophy and look up Brophy's  reference for Nijstad, Diehl, and Stroebe. You can see why readers 
prefer not to find secondary source information in your papers. 
 
Reference List Entry 

List on the reference page only the works you read.  In the example above, only Brophy, the 
secondary source, appears on the reference page.  Nijstad, Diehl, and Stroebe, the primary source, 
receive no mention on the reference page. 
 
When to Use Secondary Sources 

Avoid secondary sources when possible.  With the availability of sources on the Internet and through 
university libraries, most sources are retrievable.  When you rely on a secondary source, you raise the 
question of why you didn't seek the original.  Furthermore, you are forced to rely on the interpretation 
of the secondary source author.  You will pass along any errors he or she made in presenting the 
primary source.    Use secondary sources when the primary source is not translated into English, when 
you need to discuss reviews of the primary source material, or when the primary source information is 
not essential to your purpose. 

 
When a Source Does Not have to be Cited as Secondary 

Below is another excerpt from Brophy,  In this excerpt, Brophy is making assertions (stating opinions) 
of his own and citing the research sources on which his assertions are built.  In this case, he is not 
interpreting another source for readers; he is simply identifying his sources.  If you quote or 
paraphrase information from this portion of Brophy, you should cite Brophy himself. 

actually prove more valuable. In a review of individual and group CPS studies, Nijstad, Diehl, 
and Stroebe (2003) argued that the key question was whether group dynamics did more to 
prompt or interfere with knowledge searches producing new and useful ideas in the same 
and varied categories. With exceptions like very diverse groups, they concluded the amount 
of interference outweighed amount of stimulation. 
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Please note, however, that although Brophy is speaking for himself in this passage, he clearly did not do 
the original research (hence, his sources).  Strictly speaking, Brophy is not an original source.  He has 
adopted and shaped his position here on the work of others, not on his own research. Reporting primary 
research requires reading the original sources.   
 
Do not take information for literature reviews from someone else's literature review.  The primary source 
information in a research study is found in the author's Conclusion (Discussion, Results, Findings) section. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
-------------------------------------------------------------------------- 
Source:  
Brophy, D. R. (2006). A comparison of individual and group efforts to creatively solve contrasting types of problems. 

Creativity Research Journal, 18(3), 293-315. doi: 10.1207/s15326934crj1803_6 
--------------------------------------------------------------------------- 
 
 
CITATIONS IN THE TEXT    [174-179  (see table p. 177)] 
 
Purpose of In-Text Citation 
The purpose of the in-text citation is to lead readers to the correct alphabetized entry on the Reference 
page.  The samples that follow illustrate variations on the same in-text citation. 
 
Frazier and Paulson (2006) found that the portfolio method of assessment motivated reluctant 
writers.                
 
 
The portfolio method of assessment can also motivate reluctant writers  (Frazier & Paulson, 
2006). 

In a 2006 study, Fazier and Paulson observed that the portfolio method of assessment motivated 
reluctant writers.  

The word and must be spelled out in running text, but the 
ampersand (&) is used inside parentheses. 

Group success requires leaders who can facilitate CPS by eliciting, organizing, and coordinating varied 
offerings; helping the group devise an effective strategy for dealing with the task; reconciling conflicting 
goals; directing most competitiveness outward; and best use time and other resources (Saaveda et al., 1993; 
Wallgren, 1998). Rather than posing first solutions, good CPS leaders made unique contributions like 
conceptually organizing and ordering diverse ideas and coordinating idea evaluation (Anderson & Balzer, 
1991; Hart, Boroush, Enk, & Hornick, 1985). These things are often done by transformational leaders who 
encourage members to set long-range goals, rather than transactional leaders who reward the pursuit of 
given short-term goals (Jung, 2000–2001; Sosik, Kahai, & Avolio, 1999).  
 

 



©The Writing Center, Saint Mary's University of Minnesota Schools of Graduate & Professional Programs 17 

Relationship to Reference Page Entries 
Remember that there are 4 elements in a reference page entry: (1) Author, (2) Publication date, (3) Title, 
(4) Publisher information.  The first two elements, Author and Publication date, make up the in-text citation 
(minus the author's initials.   

So if the first elements of an entry are Lazear, D. G. (1994). 

Then the in-text citation would be  Lazear  (1994) . . .  or (Lazear, 1994).  

The in-text citation must match the author (minus initials) and date of its reference page entry so that 
readers can locate the entry. 
 
Where and When to Cite?  
Two frequent APA question are, how often should I cite and where should I cite (meaning beginning, 
middle, or end of sentence or paragraph—and inside or outside parentheses)? These are difficult questions 
and can be answered only by understanding  how you are using your sources in the paper.   
 
   Discourse About Ideas 

A literature review, for example, is organized by themes.  Instead of separately summarizing each article 
you read, you should write about themes that emerged from your review of the literature.  For instance, 
you might say something like this: 

Transformational leaders are recognized as those who inspire their followers to higher levels 
of  performance and change. 

In that sentence you are  writing in your own voice, stating an assertion for which you found support in the 
literature.  You need to cite each source you read that supported that assertion.  A good place to cite in a 
case like this is at the end of the sentence in parentheses, like this : 

Transformational leaders are recognized as those who inspire their followers to higher levels 
of performance and change (Bass & Avolio, 1993; Burns, 1978; Yukl, 1994) .  

Placed in parentheses at the end of a sentence  that way, citations are less distracting to the flow of  
ideas.   
 
Discourse About Works 

If, on the other hand, you find that the entire paragraph contains ideas from the same author (in other 
words, you would be citing the same author at the end of each sentence), then you probably need to 
introduce the author's name into the running text, where it is more noticeable, because you are now 
discussing the author or the author's work, not just  citing the author as support for your own assertion. 
Note the following example: 

Pounder ( 2009) assumed that a university classroom could be considered analogous to an 
organization, with the professor as a leader and students as followers.  Pounder concluded 
that a transformational teaching style leads  to positive student learning outcomes.  
Students with transformational teachers are motivated to work harder.* 

 
*Source: 
Pounder, J. S. (2009). Transformational classroom leadership: A basis for academic  staff  development. Journal 

of Management Development, 28(4), 317-325. doi: 10.1108/02621710910947353 
----------------------------------------------------------------------- 

 
Whichever  way you cite, parenthetically or in running text, you must at all times make clear to readers 
the sources of all your information.  Frequent citations are a necessity and are expected in academic 
papers. 
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Varying the Citation Wording 
When citing, try to vary the wording of citations in order to reduce monotony: 

1. Stieglitz and Hernandez (2002) emphasized . . .  

2. Several earlier studies (Gudmund, Farrar, & McDermot, 2004; Willum, 2000; Wright & 

Formani, 2006) were inconclusive . . . 

3. According to Khali and Kozumi (2000), earlier research failed to . . .  

4. Zarweit (2007) responded, “At no time were the subjects informed” (p. 92). 

5. Czel (1999) defined sensation seeking as behavior that . . .  

6. . . . but the results were inconclusive (Hammel, 2003). 
  

 
Avoid anthropomorphism (attributing human actions to non-humans nouns): 

Not:  A survey by Biggs and McCoy (2001) reported . . .  

But:  Biggs and McCoy (2001) reported . . . 
Surveys, research, studies, and reports don't do anything.  Their authors do.   

 
 
Must I use page or paragraph numbers for Internet Quotations? 

The APA says yes ( see section 6.05 in the manual) and offers suggestions for identifying 
unpaginated text by using paragraph numbers or section titles.   
 
 

How do I cite a personal interview?  [6.20] 
 
A personal interview is not a retrievable source, so it does not get an entry on the Reference page.  
However, it must be cited in the text as follows:  (J. J. Doe, personal communication, April 10, 2002).  If 
the name of the person being cited is written into the running text, then it need not appear again in the 
parentheses. 
 
All non-retrievable personal communications (interviews, letters, e-mail, memos, and the like) are cited 
in text but do not appear on the Reference page.  Minutes of meetings appear on the Reference page 
only if they are retrievable.  Often times the minutes of informal meetings are not published and thus not 
retrievable, in which case they should be treated the same as personal communications. 

 

TITLES: Formatting  [4.10-4.13] 

Titles follow special formatting rules when they appear on an APA reference page.  Readers familiar with 
APA can understand the nature of the sources by noting the way its title is formatting.  At first glance the 
rules appear confusing, but actually they boil down to a simple patter.  Remember that all titles fall into one 
of three categories.  Just identify the category and the follow the typing rules in the box below. 

  

?  

?  
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A.  TITLES ON THE REFERENCE PAGE  [6.29] 

 

1. Three Types of Titles.  Think of all titles as falling into three categories: 

Type 1.  Work published inside a larger work.  Examples: chapter in book, article from journal 

Type 2.  Work published alone.  Examples: book, stand-alone Internet document, brochure, 
report, unpublished dissertation 

 
 Type 3.  Periodical.  The title of the journal or other periodical 
 
      2. Three Types of Title Formatting. Each category has its own format: 

Type 1.   Do not italicize.  Capitalize only the following: (a) first word, (b) first word  after a  colon,  
(c) proper nouns.  

Type 2.   Italicize.  Capitalize only the following: (a) first word, (b) first word after a colon, (b)  
proper nouns 

Type 3.   Italicize.  For capitalization, follow the form used by the publisher. 
 

Examples 
 
 
Predicting alcoholism: College binge drinking.  National Journal of Addiction, 12(3), 2-8. 

 
  

Elgin, G. I. (2003). The politics of curriculum in American education. Boston: Boynton. 
 
 

 
B.  TITLES USED IN THE PAPER 

Normally, titles of works cited do not appear in the text of your paper.  However, if you  do use a title in 
your text, follow these formatting rules: 

Type 1.  Place inside quotation marks. Capitalize major words (see below).  

               Example: "The American Work Ethic" (article from New Psychology) 
 

Type 2.  Italicize.  Capitalize major words. 

   Example: How to Design and Evaluate Research in Education 
 
Type 3.  Italicize. Capitalize major words (or follow capitalization of publisher).  

               Examples: (a) New England Journal of Medicine,  (b) COMbusiness 
 

Note: When the first word or two of a title is used to replace a missing author in a text citation, follow 
the formatting for in-text titles. 

 
 
 
C. MORE ON CAPITALIZING WORDS IN TITLES  
 

The general rule for capitalizing words in titles used in your text is capitalize major words.  But 
what are major words?  Major words are all words except (a) coordinating conjunctions, (b) articles, 
and (c) short prepositions.  However, capitalize these words as well if they appear as the first word in 
the title: 

 The Logic and Rhetoric of Exposition  (book) 

 Type 2  

Type 1 
 

Type 3 
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a.  Coordinating Conjunctions (not capitalized) 

Coordinating conjunctions are defined as those words that connect grammatically equal 
elements.  There are seven coordinating conjunctions, and they can be arranged by their first 
letters to form the "word" fanboy:   

for, and, nor, but, or, yet 

Examples:   Forgiven but Not Forgotten 

        "The Cambridge Spelling Report: Help or Hoax?" 

         The Logic and Rhetoric of Exposition  
b. Articles (not capitalized) 

Articles are those three critical little words--a, an, and the--without which we can scarcely write a 
sentence 

c. Short Prepositions (not capitalized) 

Prepositions, like articles, are function words.  When paired with nouns, they identify relationships 
of position and time, like before sundown, between you and me, among the trees, and above 
average.  There are more than 70 common prepositions.  Do not capitalize prepositions of three 
words or fewer.  There are 13 you should not capitalize: 

as   at   by   for   in   of   off   on   out  to   up 

 
PUNCTUATION  [pp. 87-96]  

See also "Transitions and Conjunctions" 

A. Spacing [4.01]  
Each mark of punctuation is followed by one space.  (Two spaces may follow a period ending a 
sentence; however, if used the practice should be consistent throughout the paper.)   

Exceptions No space is required after 

• an opening parenthesis: 

    Departing flights (except those already noted) are temporarily grounded.  

• an opening quotation mark, and comma or period before a closing quotation mark 

  The captain remarked, “The space is inadequate.” I agreed. 
 
      All other punctuation marks are followed by one space. 

 
B. Apostrophe (')    

Use an apostrophe 

1. to show ownership or possession. 
Add an apostrophe and an s ('s) to words that don't end with an s: for example,  

somebody's car   (the car belonging to somebody) 
the men's locker room   (the locker room of the men) 
a month's rent   (the rent of a month) 

Add only an apostrophe after the s to words that already end in s. 

twelve days' pay (that is, the pay for twelve days) 
the students' tests (that is, tests belonging to the students) 
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 2.  to form contractions (e.g., could not = couldn't, he  is = he's) ; but do not use contractions in  
academic papers.  

C. Colon (:)     
1. Use a colon after a complete sentence that introduces a list. 

The breakfast menu contained the clients’ favorite foods: bran muffins, bananas, 
pancakes and maple syrup, and bacon and eggs. 

   If the introduction is not a complete sentence, no punctuation is needed after it: 

Dieters preferred low fat breakfast foods such as strawberries, unbuttered whole wheat 
toast, unsweetened cereal, and applesauce. 

2. Use a colon on the reference list, to separate publisher location from name. 

Hebring, R. J., Jr. & Vang, C. (2008). Collective wisdom, diverse experience: 
Managers’ real stories (3rd ed.). New York: Random House 

 
D. Commas: Six Rules   
The following six comma rules will enable you to punctuate most sentences correctly. 

1. Use a comma before a coordinating conjunction (and, but, or, so*, yet, nor, for) if it joins two 
sentences. 

• Ellen thought the movie was exciting, and Fred liked it more than any he had seen that 
year. 

• Fred and Ellen saw a movie and went out to dinner afterwards. (No comma needed because 
and is not joining two sentences. 

      * (when so means therefore or as a result, but not when it means so that) 
 

2. Use a comma after introductory expressions.   

An introductory expression is a word or words that lead up to the main part of the sentence. 

• Frankly, I have had enough of this cold and rainy weather. 
• When our bakery closed down, Jan had to make her own bread. 
• Confused by the freeway signs, Ralph got hopelessly lost in Chicago. 

 
3. Use commas to separate three or more items in a series.   

     Use a comma after each item, including the one before the conjunction (and or or). 

• Protestors wore black pants, red shirts, and green sashes. 
• Students can study before class, after school, or on Saturday afternoon. 

 
4. Use commas to set off words and phrases that interrupt the sentence if those words are not 

essential to the purpose of the sentence.   

• Michelle took her seat at the table and, much to everyone's surprise, blew her nose on the 
tablecloth.             

• I liked Brad's sense of humor.  His lewd jokes, however, deeply embarrassed his 
grandmother.  

• Bill, a man of much courage, grabbed the burglar's hand and bit off his trigger finger. 
 
5. Use a comma to set off a phrase at the end of a sentence if that phrase refers to the entire 

sentence that precedes it. These phrases will usually begin with a word ending in –ed or –ing.  
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Example: 

The company recognized every branch manager, [raising morale and encouraging high 
standards]. 
In the sentence above, the bracketed phrase refers to the entire sentence (underlined)  that that 
precedes it.  Therefore the phrase is set apart from the sentence by a comma.  (The relationship 
between the sentence and the phrase is one of cause and effect).    

The company recognized every branch manager  [raising  morale and encouraging  high 
standards]. 
In the sentence above, the bracketed phrase refers only to the underlined phrase, not the entire 
sentence.  Furthermore, because the underlined phrase is necessary to identify which branch 
managers got recognized (only those raising morale and encouraging high standards), the  phrase 
should not be set off with a comma.  If a comma were added, the sentence would change to mean that 
all branch managers were recognized and that  the recognition raised morale and encouraged high 
standards (as in the sentence in the previous example).,  

Example: 

Teachers offered rewards to the students, [trying to improve test scores].                        

With a comma, the sentence means that teachers offered rewards in an attempt to improve test 
scores.  The bracketed phrase refers to the entire sentence (underlined)  that precedes it. Therefore, 
the phrase is set apart from the sentence by a comma. (The phrase trying to improve test scores might 
be better placed at the beginning of the sentence and set apart by a commas.) 

Teachers offered rewards to the students  [trying to improve their test scores]. 

Without a comma, the sentence means that teachers offered rewards only to students who were trying 
to improve their test scores. (The phrase is necessary to identify of which were offered rewards; 
therefore, the phrase should not be set apart by a comma. 

   Example: 

Close communication exists among the cell types, [allowing interchange of secretions 
between the hormones].  
In the sentence above, the bracketed phrase refers to the entire underlined sentence, not just to "cell 
types."  (The relationship between sentence and phrase is one of cause and effect).  the sentence 
above means that the interchange results from the close communication that among the cell types.  
Allowing refers to the entire phrase close communication exists among cell types  

Close communication exists among the cell types  [allowing interchange of secretions 
between the hormones].   
Without the comma, sentence above means that communication exists only among cell types that 
allow the interchange.  The phrase in brackets refers only to cell types, not to the entire underlined 
sentence. Furthermore, the phrase is necessary to identify which cell types allow the interchange; 
therefore, the phrase should not be set apart with a comma. 

6. If rules 1-5 don’t apply, you probably don’t need a comma.  Most people over-use commas.  

Exception.  Occasionally, a comma is needed to prevent the misreading of a sentence, even if one of 
the five rules doesn’t apply. Note the following example: 

      Patients who can discuss side effects with their doctors before undergoing surgery. 
Adding a comma will prevent misreading of the sentence: Patients who can, discuss side effects 
with their doctors before undergoing surgery. 

 

 



©The Writing Center, Saint Mary's University of Minnesota Schools of Graduate & Professional Programs 23 

E. Dash (—)    
Dashes are intended to separate words and phrases.  To create a dash, type two hyphens with no 
space before, after, or between them.  Use dashes to indicate an interruption (e.g., Students in Group 
2—those who received no training—were least successful at accomplishing the task.) 

 

F. Hyphen (-)  See also APA [3.11] 
Hyphens are used to connect words and parts of words.  The hyphen key is located next to the 0 on the 
keyboard. Type hyphens with no space before or after (for example, a rags-to-riches story). 

 
G. Parentheses (  )      

In academic and professional writing, parentheses are used (a) to enclose citation material, and (b) to 
enclose letters used for lists, as in this sentence.  They are also used (but sparingly) to enclose words 
or phrases that are not essential, as illustrated in this sentence..   

 
H. Quotation Marks (" ")   

In academic writing, quotation marks are used primarily to enclose direct, word-for-word passages 
borrowed from another source. 

Commas and periods that finish quotes are always placed inside quotation marks. 

Other marks of punctuation are placed outside quotation marks unless they are part of the quoted 
material. 

Uses of quotations and use of capitals in quotations are topics dealt with elsewhere in this booklet. 
 
I. Semicolon (;)    

Use a semicolon 

a. between two sentences when a period is not desired: 

Sales of buttons and tee shirts were higher than expected; few people bought flags, 
however. 

b.  to separate elements in a series if the elements themselves contain commas. 
 

Commission membership included Janet Dubois, mayor; Arun Ramish, city attorney; Tyreesha 
Tomlin, school board president; and Harold Rosen, state representative. 

 
 

HEADINGS   [3.03] 
 
Placing headings in your paper is important for several reasons:   

• They help readers follow the organization of your paper. 
• They keep you, the writer, focused and organized. 
• They provide transition from one section to the next. 

 
Applying the Five Levels 
APA follows a fairly simple heading style.  There are five levels, but most students usually use  only two or 
three, and occasionally four levels for a capstone paper.  Doctoral students may use all five levels for a 
dissertations.  After typing your title on the first page of  the paper (centered, without boldface or italics),  

• Label the major subdivisions of your paper with level 1 headings.  Use level 1 headings also to 
label the reference page, abstract, and table of contents. 

• Use level 2 headings to subdivide level 1 sections. 
• Use level 3 headings to subdivide  level 2 sections 
• Use level 4 headings to subdivide  level 3 sections 
• Use level 5 headings (if you are a doctoral student preparing a dissertation) to subdivide a level 4 

sections. 
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• Level 1  Center and boldface; capitalize major words.    
• Level 2   Place at left margin and boldface; capitalize major words. 
• Level 3  Indent one tab space and boldface; capitalize only first word and proper nouns; place a 

period at the end.  Turn off bolface and begin paragraph text after the period. 
• Level 4  Same as level 3 but add italics (keep boldface). 
• Level 5  Same as level 4 but remove boldface (keep italics). 
 
 
 
 
 
 
 
 
 

NOTE: The title of the paper is not considered one of the 5 levels.  Type the title on the first page of the 
paper by centering it, without boldface or italics, and capitalizing the first letter of major words (see  
"Capitalizing Titles in Your Text" in this booklet or see APA Section  4.15).  
 
Correction 

The sample paper in the APA manual, p. 58, contains an error: The page shows a level 5 heading 
subdividing a level 3 heading.  The level 5, of course should be a level 4.  This error may be corrected in 
later printings of the 6th edition. 

Wording of Headings 

• Headings should not be complete sentences or questions: 

o Not  Cognitive Therapy Is Effective for Treating Depression 
o But  Cognitive Therapy for Depression 

o Not  What Are the Characteristics of Transformational Leaders? 
o But   Characteristics of Transformational Leaders  

• Headings should not contain abbreviations. 
 
 
Paper with One Level of Heading 

 
 

 

 

Title appears on first page and title page.  Title 
is not considered one of the 5 heading levels 

 Heading levels 1, 2, 3, and 4 are boldfaced. 
 Heading levels 3, 4, and 5 are indented (on same line as text). 
 Heading levels 4 and 5 are italicized (but 5 is not boldfaced). 
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Paper with Two Levels of Heading    
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Paper with Three Levels of Heading  
 

Title appears on first page and title page.  Title 
is not considered one of the 5 heading levels 

Note capitalization of level 3 headings: 
Capitalize only the first word and proper nouns. 
Levels 1, 2, and 3 are boldfaced. 
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Papers With Four Levels of Heading 
 

  

Title appears on first page and title page.  Title 
is not considered one of the 5 heading levels 

Note capitalization of level 3 and 4 headings: 
Capitalize only the first word and proper nouns. 
Levels 1, 2, and 3, and 4 are boldfaced.  Level 4 
is also italicized. 

NOTE: Level 5 headings are not illustrated here because they 
are rarely used outside dissertations.  Level 5 headings, if 
used, look like level 4 without the boldface. 
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Headings in an Appendix   [2.13] 
 
If your paper contains an appendix (see APA section 2.13), type the word appendix  as you would type the 
title of your paper (centered, not boldfaced or italicized, major words capitalized, [see APA  p. 39]). The title 
of the appendix is separate from any headings used within the appendix. If headings are used within an 
appendix, follow heading guidelines used in the paper, beginning with level 1. 

 

How do I avoid "orphan" headings?  
Headings that  stand alone on a line can get separated from their text when they occur at the bottom of a 
page.  (Turning on widow/orphan control won't help with headings.)  Although the APA shows "orphan" 
headings in its sample papers (pp. 41-59) , many people prefer to avoid them.  Do not press the Enter key 
repeatedly to move a heading to the next page because doing so will leave blank lines in your paper when 
you revise and cause other headings to move.   
 
To prevent headings from separating from the text, follow these instructions for Microsoft Word 2007 users:   
 

1. Place the cursor in front of the heading . 
2. On the Ribbon Bar, select either the Home tab or the Page Layout tab. 
3. Find the Paragraph section and open it (small arrow to right of "Paragraph"). 
4. Click the tab for Line and Page breaks.  
5. Click Keep with Next 
6. Click OK 

If you find yourself using this function repeatedly, you may want to put a "Keep With Next" shortcut on the 
Quick Access Toolbar.  For instructions, go to the "Using Microsoft Word for APA Tasks" section of this 
booklet. 

 
LISTS IN THE TEXT (SERIATION) [3.04] 

 
Using Bullets 

The APA allows the use of bullets, rather than numbers, for vertical lists when the order of items is not a 
factor.  To create a bulleted list, use the auto-formatting function on the Home tab of the Ribbon bar:  
The bullets should be ½ inch from the left margin, in line with paragraph indents. For formatting  
directions, see the  "Using Microsoft Word 2007 for APA Tasks" section of this booklet. 

• Bulleted lists summarize.  They should not replace a detailed explanation or commentary. 
• Items in bulleted lists must be grammatically parallel  (see parallelism in this booklet and in the 

APA manual). 
• Bulleted lists are double-spaced like the rest of the text. 
 

Using Numbers 

Use numbers instead of bullets when the order of the items is important—for example, in presenting a set 
of ordered steps in a process.  Follow the formatting directions for bullets . 

 
Using Lettered Series Within a Paragraph or Sentence [p. 64]  
When a series or list of items appears within a sentence or paragraph, the items can be—but don’t have to 
be—designated by letters (not numbers) in parentheses.  The APA manual, p. 64, provides very clear 
examples.  Whether the items are in a single sentence or not, remember the serial comma—that’s the 
comma before the last item, as in the following two examples [APA  4.03]. (Examples below are single-
spaced but should be double-spaced in your paper.) 

EXAMPLE 1:  Unlettered Seriation in a Sentence 
Researchers divided participants into four groups on the basis of age, gender, height, and weight. 

  

?  

 

Serial comma  
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EXAMPLE 2: Lettered Seriation in a Sentence or Paragraph 

In the text, cite all the research sources you used to produce your text, even if you don’t quote the sources 
directly. Cite each source each time you refer to it in your paper.  Citations serve three functions: (a) to give 
credit to the persons whose ideas you used, (b) to allow readers to find your original sources, and (c) to 
establish the credibility of your presentation.   Most of the time, you will comment on or paraphrase the 
ideas of others.  Occasionally, you will provide direct or indirect quotes to emphasize or clarify a point.  
Note, however, that you must cite sources, regardless of whether you quote or paraphrase. 

 
 
TABLES and FIGURES [5.01-5.30] 

 
Use tables and figures sparingly, and only if the information contained in them is essential for 
understanding the text of your paper.  Tables and figures should supplement, not duplicate, what is 
expressed in the text.  Mention the table or figure at the appropriate point in the text.  Refer readers to the 
table or figure with words such as  

 As shown in Table 2, the results were . . .  

 configuration of parts (see Figure 1) depended upon . . .  

Numbering and Placing Tables and Figures 

• Assign numbers to table or figures in order of their appearance in the text, and number them 
separately from one another (i.e. Table 1, Figure 1) [5.05].  

• Provide a title [5.12] for each table and place the title above the table, after the table number (see 
p. 132 of APA manual for illustration). 

• Provide a caption [5.23] for each figure and place the caption beneath the figure, after the figure 
number (see 159 of APA manual for illustration). 

• APA style places tables and  figures on separate, unnumbered pages after the Reference page.   
However many University programs prefer that each table and figure appear in the text at the point 
where it is first mentioned. Check with your instructor, advisor, or program director for the 
preference of your program. 

• If the table or figure appears in an appendix, the appendix letter appears before the number of the 
table or graph, e.g., Figure A2.    

• In APA style, tables have horizontal lines but not vertical lines.   
 
Citations for Tables and Figures  

Doctoral students must obtain copyright permission to use table and figures from another source in 
their dissertations, and must include a copyright permission footnote (explained on p. 38 of the 
manual) in their text.  For students not submitting papers for publication, the following guidelines are 
summarized from the APA  manual.  

• If you obtained a table or figure from another source, you must, according to the APA manual, “give 
credit in the figure caption to the original author and copyright” (p. 200).   

• If you created the table or figure yourself, but within the table or figure you used information 
reproduced or adapted from another source, you must provide a source note (similar to a reference 
entry) at the bottom of the table or figure.  No entry is needed on the reference page unless  that 
source was cited elsewhere in the paper.  See APA 5.16 for examples of table source notes, and 
5.23 for examples of figure source notes. 

APA rules governing tables and figures are complex. For clarification or additional information refer to the 
APA manual, chapter 7 or  the manual's index. 

 

  

 

Serial comma 



30 ©The Writing Center, Saint Mary's University of Minnesota Schools of Graduate & Professional Programs 

Table Example (size reduced) 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

Figure  Example (size reduced) 
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PART TWO: TIPS TO IMPROVE YOUR WRITING 
 

"FLOW": HOW TO IMPROVE IT 
 
What is "flow"?  People sometimes use the informal (and imprecise) term flow, as in "does my paper flow?” 
when they want to know if readers can follow ideas easily.  This quality of discourse called "flow" (writing 
professionals refer to it as coherence) is influenced by a number of factors.  Flow, or coherence, cannot be 
addressed as a single concept; it needs to be analyzed to identify its underlying components.   

Keep in mind that academic writing is different in a number of ways from less formal discourse such as 
personal letters and reflections, newspaper articles, and advertising brochures.  First, of all, academic 
writing usually involves complex and abstract concepts, explained thoroughly and objectively.  Academic 
writing often employs specialized vocabulary requiring definitions or context clues.  In addition, academic 
writing is idea-dense, which means that a lot of information is conveyed in a small space.  It is also high 
stakes writing, in that misunderstandings by readers can be costly.  Finally, academic writing must be 
understood by a worldwide audience of English readers, in whose countries another English dialect may 
prevail.  For all these reasons, academic writing must follow a strict model of Standard Formal English, the 
model shared by most academics around the world. 

Because of the complex and high stakes characteristics of academic and professional writing, readers must 
rely more heavily of the structure of the text to understand it, text structure that includes consistency, 
organization, grammar, transitions, and diction. 
 

Factors That Affect "Flow" 

• Consistency.  Keep terminology consistent.  If you are writing about the relationship between 
"company service representatives" and "customers," don’t call them "company staff" and "clients" in 
the next sentence or paragraph.  Keeping the terms consistent throughout the paper helps readers 
concentrate on concepts instead of trying to figure out if you are still referring to the same thing, or 
why you changed the terms.  It's good to avoid unnecessary repetition, but consistency is not the 
same as repetition—or, if you prefer to think of it this way—consistency is "good" repetition.  

• Headings.  Headings and subheadings are essential to organization.  They provide a quick 
overview of content; they establish logical relationships among sections of the paper and provide 
transition from one section to another.  Imagine yourself driving through a large foreign city without 
road signs marking highways and streets.  Readers experience something similar as they navigate a 
paper with no headings.  Here is the best part: Headings keep the writer, as well as the reader, 
organized.  Establishing headings before you write helps keep you focused.  For tips on effective 
headings, read the "Headings" section of this booklet.  

• Pronouns.  Pronouns replace or "point to" words you have used previously in your text:  Students 
learn more from teachers who inspire them. If the connections are unclear, the ideas become 
disconnected.  To avoid pronoun confusion, read "Pronouns: Avoid Confusion" in this booklet, and 
follow up with appropriate sections of the APA manual.  

• Quotations. Quotations disrupt the flow of ideas and mix writing styles.  If you must use a quotation, 
keep it very short.  Avoid quoting complete sentences and paragraphs.  Read the "Quotations" 
section of this booklet for do's and don'ts.  

• Audience. Disruption to flow occurs when there are gaps in information or disorganization in 
presenting it. Gaps and disorganization occur when the writer forgets the audience.  We tend to be 
egocentric when we compose, thinking of what we know or intend to say rather than on what the 
reader needs to know or might misinterpret.  Try to read your own paper from an audience point of 
view.  

• Transitional devices.  If you read the second paragraph under the heading "FLOW: How to 
Improve It" above, you will see examples of transitional devices:  First of all, . . . In addition,  . . . also 
. . .  Finally, . . . For all those reasons.  These transitional words and phrases keep nudging the 
reader forward and then, finally, announce a summary statement, "For all those reasons. . . . "  You 
will find a list of transitional words and phrases in this booklet under the "Transitions" heading. 

Some transitional devices are non-verbal: for example, (a) labeled lists (like this one) within 
paragraphs, (b) numbered lists arranged vertically, and (c) bullet points.  
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• Organization.  When you think about organization, think about levels.  The entire paper has an 
organization; sections of the paper have organization; paragraphs have organization; and, yes, 
sentences have organization.   

1. Overall organization. When you consider the organization of your paper, ask yourself, What is 
the most logical way to present this particular topic?: chronologically? climactically? most-to-
least -important? cause-and effect? compare-contrast? problem-solution? myth-and-fact? 
sequence of steps? reverse order?  Remember that after you decide on an overall 
organization, you may decide to use another organizational method within a specific section. 

2. Section organization.  The organization of a section depends upon the purpose of the section.  
Let's take a literature review section as an example here because many students struggle with 
the flow of the literature review.  The purpose of most graduate literature reviews is to 
synthesize (integrate, interrelate) conclusions of others to arrive at a more-informed conclusion 
or to answer a question.  Therefore, literature reviews are generally organized thematically: 
that is, by subthemes of the big topic.  You can determine the subthemes before you start the 
research (I want to answer the question, what factors support independent learning in adults?  
I probably need to know about  motivations of adult learners, social characteristics of adult 
learners, cognitive functioning of adult learners—so these will be my subheadings).  But as you 
read the literature, you keep running across another theme you call "psychological barriers," so 
you may add or replace a subheading.  Organizing a literature review section by presenting 
one article summary after another, instead of thematically, is guaranteed to confuse your 
readers (and probably you). 

3. Paragraph organization.  Not all paragraphs need to be organized exactly the same way (ho-
hum), but most paragraphs should contain a topic sentence stating the main idea, followed by 
supporting statements (examples, illustrations, explanations, and so on).  Refer again to the 
second paragraph under “Factors That Affect Flow" above.  What do you notice about its 
organization?  Look at another paragraph organization, this time under the heading 
"Headings." 

• Parallelism.  Did you notice that sentence organization was not addressed under the "Organization" 
heading?  That is because an important aspect of sentence organization falls into a special category 
called parallelism, which refers to grammatical "sameness" within elements of a sentence. You can 
read about this under the "Parallelism"  heading in this booklet.  Poor parallelism will not go with 
your flow.   

While we are on the subject of sentences as organization, take note that the standard word order of 
an English sentence is [subject]+[verb]+[object-or-modifier].  For example, 

Sue hates fruitcake.  Sue [subject] hates [verb] fruitcake [object]. 

Ahmed feels frustrated.   Ahmed [subject]  feels [linking verb] frustrated [modifier of 
subject]. 

Whenever you find yourself with a disorganized sentence, reduce it to its simplest form: 
subject+verb+object-or-modifier.  If you can't identify those three elements, rethink the idea and try 
again.  If you identify several subjects, verbs, and objects or modifiers, you may need more than one 
sentence to express the idea.   

• Wordiness.  A section of this booklet is devoted to the problem of wordiness, and you should read 
it.  Keep in mind that the human brain can't process more than a few bits of information at a time.  
When we read, we "chunk" together bits of information into meaningful ideas.  When you introduce 
unnecessary words into your presentation, you place a heavier burden on the reader's ability to 
process the information:  it's harder to "chunk" together all those extra bits of information (words).  
Eventually, the reader loses the flow.  Wordiness comes naturally to all writers--in part because we 
test out several ways of saying the same thing, but forget to delete some of them; in part because 
the words we write are hard-earned, and we hate to give them up.  Learn to locate unnecessary 
words.  Your readers will thank you.  Your flow will be improved.  Your grades will rise. 

• Repetition. No doubt previous writing teachers told you not to repeat yourself.  Your teachers forgot 
to add the word unnecessarily.  Repetition of key words and phrases can enhance flow by helping 
readers relate themes and identify patterns.  If you need to repeat a key point, do not say "as stated 
earlier"; just do it.  Your readers know you stated it earlier, and if they don't, don't remind them that 
you are repeating yourself.  Repetition can also be useful as a rhetorical device to emphasize a 
point.  If you doubt that, read Dr. Martin Luther King's "I Have a Dream Speech."  You can find a 
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much humbler example if you go back to the second paragraph under the “'FLOW': How to Improve 
It" heading.  Does it leave any doubt that this booklet deals with a specific style of writing? 

• Verb tense. Unnecessary or illogical changes in verb tense cause readers to stop and scratch their 
heads, wondering where they are in the flow of time.  APA simplifies verb tense choices by insisting 
on (a) past tense for the reporting of outcomes, (b) future tense for relating proposed or expected 
actions, and (c) present tense for expressing current or ongoing conditions.  So . . .  

Past:  Barnes argued . . . Bosso announced . . . Nguen predicted . . . They observed . . .  

Future:  I will interview . . . participants will be chosen . . . they will return the surveys . . .  

Present: Obama believes . . . the earth revolves . . . women live longer . . .  

Note the difference:  As a group, smokers have a higher rate of heart disease. 
    As a group, smokers in the study had a higher rate of heart disease. 

 
 
APOSTROPHES  
To Show Ownership or Possession 

• Add an apostrophe and an s ('s) to words that don't end with an s. 
somebody's car (the car belonging to somebody) 
the men's locker room (the locker room of the men) 
a month's rent (the rent of a month) 

•  Add only an apostrophe after the words that already end in s.  
twelve days' pay (that is, the pay for twelve days) 
the students' tests (that is, tests belonging to the students) 

• To show joint possession, add an apostrophe and s to only the last word in the group: e.g.,  
Laurel and Hardy's last movie (a movie by the team of Laurel and Hardy.) 

• But to show individual possession, add an apostrophe and s to each word in the group: e.g., 
Fossum's and Day's opinions (the opinions of Fossum, and the opinions of Day) 

 
To Form Contractions   Note: Do not use contractions in formal academic papers. 

 Show Omission of Letters with Apostrophes 

Could not = couldn't    He is = he's     They are = they're     Cannot = can’t      

Correct an Especially Troublesome Error 

It’s (a contraction) means it is (e.g., It’s not snowing now). 
Its means belonging to it (e.g., The school lost its funding). 

To test for correctness, ask yourself, “Do I mean it is?” 

Avoid Misuse of apostrophes.  

Do not use an apostrophe for simple plurals.  

Wrong:  All the player's knew this was the last chance to score. 
Right:    All the players knew this was the last chance to score. 

Do not use an apostrophe for pronouns that already indicate possession. 

Wrong:  We didn't know the suitcases were her's (your's, their's, our's). 
Right:    We didn't know the suitcases were hers (yours, theirs, ours). 

In APA style, do not use apostrophes for plurals of numerals or letters.    (See also) 
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Whenever Harry has free time, he enjoys  
 (a) sailing,  
 (b) hiking,   
      and 
      (c) to play basketball. 

PARALLELISM: Improve Sentence Construction  
 

Parallelism means that all sections are grammatically equal or balanced.  Consider the following example: 

Whenever Harry has free time, he enjoys sailing, hiking, and he plays basketball. 
Remember that old jingle from Sesame Street? 
                  
     One of these things is not like the others . . .     

 
What is not like the others, of course, is the phrase 
to play basketball.  It is grammatically unparallel.  The 
sentence would be better written as follows: 
 
 Harry enjoys sailing, hiking, and playing basketball.   
 
That way, each of the three elements is expressed in grammatically parallel form. 
 
Parallel sentences are easier for readers to grasp, and they indicate that you have thought through 
carefully what you intend to write.  Everyone would understand (though maybe not appreciate) the 
sentence about Harry, even if it weren’t parallel.  The sentences you write in your paper, however,  are 
likely to be more complex and carry more sophisticated messages than Harry likes sailing, and their ideas 
much more sophisticated, causing readers to rely more on the grammatical structure. 
 
Here are two examples of sophisticated sentences with parallelism problems: 

1.  Example 1 

       Unparallel 

The course instructor helped us see the necessity of designing meaningful curriculum, 
meeting the required standards, and to keep the human element in mind. 
 

      Parallel 

The course instructor helped us see the necessity of designing meaningful curriculum, 
meeting the required standards, and keeping the human element in mind. 
 

2.  Example 2 

     Unparallel 

Johnston hypothesized that with drug X, post-operative recovery would be fast, improved 
respiratory status, and with better pain control than drug Y.                             
 

     Parallel . . . but 

Johnston hypothesized that with drug X, post-operative recovery would be fast, respiratory 
status would improve, and pain control would be better than drug Y. 
 
The sentence still has problems because the comparison is not clear and the parallel elements are 
awkward; so let’s take the sentence a step further: 
 
Parallel and Improved 

Johnston hypothesized that, in comparison to drug Y, drug X would speed post-operative 
recovery, improve respiratory status, and provide better pain control. 
 

In the last example, each element begins with a simple verb to eliminate the awkward and repetitious 
would be construction.  Also, the comparison is clarified by placing the items being compared—the 
drugs—in the same part of the sentence. 
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PRONOUNS: Avoid Confusion 
To avoid repetition of nouns, writers use pronouns as substitutes for nouns already named. 

Jamison told the woman that his (Jamison's) table was wobbly because his (Jamison's) son had lopped off 
its (the table's) leg with his (Jamison's son's) toy saw. 

 Pronouns are extremely useful as long as their antecedents (the words they stand for) are absolutely 
clear.  When pronouns are vague—when their antecedents are not clear—readers are left to guess at 
their meanings.  Such guessing irritates readers and causes misinterpretations.  (Lawyers know a lot 
about pronouns!) 

• Make sure that pronouns refer to something specific and that what they refer to cannot be 
misunderstood.   

Managers wanted new policies immediately, but this didn't happen until June. 

What exactly does this stand for in the sentence above?  This managers?  This policies? 
No single antecedent exists for this.  The sentence needs to be recast.  Here are some possibilities: 

 
Managers wanted new policies immediately but didn't get them until June. 

Managers wanted new policies immediately, but these new policies weren't implemented until 
June. 

This, that, these, and those are pronouns frequently used carelessly, leaving readers to ask, "This 
what?"  "That what?" 

• Do not use this, that, these, or those  unless the antecedent has already been named. 

Suddenly this woman rose from her chair and stalked out. 

Unless this woman has been introduced to readers in a previous sentence, they will wonder," What 
woman?" 

• If you have trouble with vague pronouns, avoid using this, that, these, and those all alone. 

Edwards' boundless optimism creates high expectations on a limited budget.  That worries his 
supporters. 

 What worries Edwards' supporters: his optimism, the high expectations, or the budget?  The word that 
alone doesn't tell us.  Use the appropriate term after that.  For example, 

Edwards' boundless optimism creates high expectations on a limited budget.  That optimism worries his 
supporters. 

Double check your use of which, that, who.  Readers usually associate a pronoun with the noun 
closest to it.   

Homeless people waited for hours in the cold rain to get into the shelter, which made many of  
them  ill. 

How alarming to think that the shelter made them ill!  That's what the sentence suggests, however.  The 
word which is associated with the noun closest to it: shelter.  Recast the sentence to place which next to 
the noun it refers to: 

To get into the shelter, homeless people waited for hours in the cold rain, which made many of 
them ill. 

Perhaps it wasn't just the cold rain that made them ill.  To include the waiting, recast the sentence 
again, this time eliminating which: 

Waiting in the cold rain for hours to get into the shelter made many of the homeless people ill. 

• Avoid the Great Unnamed.   

 It was not revealed by the authors why only women were included in the trial.  

It seems not to refer to anybody or anything in the sentence.  (Actually it refers to the entire phrase why 
only women were included in the study, making its use redundant. )  Recast the sentence: 
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The authors did not reveal why they had included only women in the trial.  

• Never use you in academic writing.   

The study showed that you can reduce the risk of stroke by taking one baby aspirin per day. 

The use of you suggests a specific reader, who, even if known, should not be addressed directly.  Such 
direct forms of address are just too chummy for academic or professional writing.  Recast the sentence: 

Showen (2000) concluded that taking one baby aspirin per day can  reduce the risk of stroke. 

• Never use we/us or they/ them unless those pronouns refer to specific individuals.  

We know that people pay attention when their money is at stake. 

Who are the we in the sentence above?  The writer is including himself and some unspecified others.  
Unspecified means vague.  The use of we creates another rhetorical problem: by including all readers, 
the writer ensures that somebody will disagree.  Using we to mean everyone challenges someone to 
disagree, thereby creating the opposite effect intended.   

If a work is co-authored, using we to refer specifically to the authors is fine: 

We  (the other author and I) designed the study to exclude girls between the ages of 6 and 8 
years. 

Am I allowed to use "I" or "we" in a paper? [APA p. 69] 
 
Yes.  In fact you should.  If you refer to yourself as "the author" when describing your methods, you will 
confuse readers, especially if your paper contains references to other authors.  When you describe your 
methods, use "I" (or "we" if you have co-writers).  The APA addresses the issue on p. 69 under two 
headings: "Third person" and "Editorial we." 
 
TRANSITIONS and CONJUNCTIONS: Punctuation and Meanings 
   
Coordinating Conjunctions:  for, and, nor, but, or, yet, so 

1. Lucy didn’t like the way the contest was run.  She let the judges know it. 
2. Lucy didn't like the way the contest was run, and she let the judges know it. 

The second example is a compound sentence—two independent clauses joined by coordinating 
conjunction.   

Punctuation Rule: Use a comma before a coordinating conjunction when it joins two independent 
clauses. 

 
Subordinating Conjunctions:   as, after, although, because, before, if, when, while, since, until, unless, so 
(that), whether, even though 

1. The contest was unfair.  Many people did not applaud for the winner. 
2. Because the contest was unfair, many people did not applaud for the winner. 

 3. The winner could not enjoy her victory because she knew the contest was unfair. 

The last two examples are complex sentences--one independent clause and one dependent clause.  
The dependent clause starts with a subordinating conjunction. 

Punctuation Rule:  When a dependent (incomplete) clause begins a sentence, use a comma at the 
end of the clause.  When the independent (complete) clause begins the sentence, a comma is not 
necessary before the conjunction. 

 
Adverbial Conjunctions:  consequently, furthermore, however, in fact, indeed, likewise, moreover, 
otherwise, therefore 

1. Everyone wants a new set of rules.  Changes are not possible until next year. 
2. Everyone wants a new set of rules; however, changes are not possible until next year. 

The second example is a compound sentence—two independent clauses 

Punctuation Rule:   Use a semicolon between the independent clauses and a comma after the 
conjunction. 

 

?  
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Transition Words:  Adverbial conjunctions can be used as transition words, but so can many other words.  

Examples are simple sentences—one independent clause each. 

1. Everyone wants a new set of rules.  However, changes are not possible until next year. 
2. Everyone wants a new set of rules.  Changes are not possible, however, until next year. 
3. Everyone wants a new set of rules.  Changes are not possible until next year, however.  

Punctuation Rule: Punctuate the sentences and then set off the transition words with commas. 
 

TRANSITIONS AND THEIR MEANINGS 

Transitional words and phrases link ideas in one clause or sentence with those in the next. They help the 
reader see the relationships between ideas.  Think of them as bridges linking one idea to another, or as 
road signs that lead the way. 

Some of these words may be used between independent clauses that have been joined by a semicolon.  In 
that case, they are called adverbial conjunctions, and they are set off by a comma.  Note this example:  
Lara was loud, bossy, and insensitive; consequently, people avoided her whenever possible.  Transitional 
expressions placed elsewhere within the clause are punctuated with commas.  Here are some frequently 
used transitional expressions and their most common uses.   
 
Example:  specifically, for instance, for example, to illustrate, in particular, especially, most importantly 

Addition:  also, furthermore, besides, likewise, moreover, again, finally, in addition, in the first (second, 
third) place, what is more, at last, next, beyond that 

Comparison and Contrast:  Comparison:  similarly, likewise, at the same time, in the same way, in like 
manner   Contrast:  however, nevertheless, still, nonetheless, conversely, rather, whereas, on the one 
hand, on the other hand, on the contrary, by contrast, in contrast 
Repetition:  again, in other words, once again, to repeat, as stated 

Cause and Result:  therefore, thus, hence, consequently, as a result, all in all, for this/that reason, 
because 

Conclusion:  finally, then, thus, hence, therefore, in conclusion, to summarize, in short, all in all, in brief, on 
the whole 

Time:  earlier, before, since, subsequently, eventually, gradually, meanwhile, simultaneously, now, 
immediately, recently, suddenly, currently, during, then, next, after a while, at last, in the meantime, until 
now 

Concession:  doubtless, surely, certainly, naturally, granted, no doubt, admittedly 

Place:  elsewhere, here, there 
 
Avoid Confusing Transitions and Conjunctions:  Don’t make readers guess at your meaning. 

Avoid using since when you mean because.  Since the troops returned from the war, boot sales have been 
increasing.  Have boot sales been increasing because the troops returned or only  from the time they 
returned?. 

Since had a temporal meaning: from that time until now.  Because means only one thing: for the reason 
that.   

Avoid using while when you mean although.  While senators were on recess, the President was busy 
writing administrative orders.  Do you intend emphasize the contrast between the vacationing senators 
(although) and the hardworking President, or do you want to say that the President was busy but just while 
the senators were on break? 
 
 
SPELLING TROUBLESOME WORDS 
Because of the complexity of English spelling rules and pronunciation, it is easy to confuse some of our 
most common words.  The word processor’s spell check can’t help with these because  the words may be 
correctly spelled but just confused with a sound-alike word.  Determine which sets of words confuse you, 
and then memorize ways to keep them straight.  Here are some hints.   
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Accept/except  Except always means that something/someone is left out (x'd out): 
      Everyone is going except Sam.  (Sam is x'd out.) 

Affect/effect  Effect means result, so try substituting result.  (Note that both result and effect have an  
e in the beginning.) 

1. The effect of Gena's greed was that she lost her inheritance.  (Result makes sense, so effect 
must be correct.) 

2. I wonder how this powder will affect my skin.  (Result does not make sense, so affect must be 
correct.) 

Between  is used only between two: a secret between my mother and father 
Among  is used with more than two: a fad among American teens  

Course refers to a course of study and contains a u.  U (you) pass a course. 
Coarse means crude, rough, or rude, like the word arse (ass), which it contains. 

Here/Hear   Here is a place (here and there).  Hear means listen (has an ear in it). 

Loose/lose   Remember that loose rhymes with goose and both have double o's.  If you want to use 
lose, you have to lose an o. 

Passed is something done.  (Harry passed the quiz.  The bus passed us by.)  
Past refers to a condition,  location, or time. 

The time for grief is past (a condition).   
Drive past the Dairy Queen (a location).   
Have you had car trouble in the past (a time)? 
Note the difference in past and passed:   
Glenda passed Henry in the park. (She did it.) 
She rode past him on her bike. (Where she rode--a location) 
She had done that in the past. (When--a time) 

Quit/quite/quiet 

1. Quite rhymes with white (substitute qu for wh) 
2. Quit rhymes with grit (substitute qu for gr) 
3. Quiet has two syllables: qui-et  

Should have/Would have/Must have     

Some people write should of  when they mean should have.  People do this because, when 
pronounced, should have gets run together ("should’ve") so that it sounds like should of.  In fact, 
no construction called should of exists in the English language.  Always write should have, would 
have, must have .    

Then/than     

1. Then has to do with time, and it rhymes with when, another time word:  I can't go out when it 
rains.  Then (at that time) I work on my school work. 

2. Than is used with comparisons:  She is taller than I am. 
3. Then rhymes with when.  Than rhymes with fan. 

There/their/they're 

1. There is a place, like here and there. 
2. Their  shows ownership (their coats),as an heir owns the family fortune. 
3. They're is a contraction for they are.  Try substituting they are to see if it makes sense in the 

sentence. 

Though (pronounced tho, rhymes with go) means although. 

Thought refers to brain activity: She thought carefully before answering. 

Tough (pronounced tuff) means hardy or thick-skinned.  (Associate with rough). 

To/Too To and too can be told apart by the fact that too means also or in excess and it has an 
excessive number of o's.  (It has one, and one more.) 
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Wear/were/where    

1. Wear  your earrings on your ear.  Wear is something you do.  
2. Where is about a place:  Where is the Tootsie Roll  I left  here?   

Whether/weather  Weather contains the letters for heat. 

Contractions:  Test contractions by substitutions in the following way. Do not use contractions in 
academic papers. 

 Its or it's       The dog chased its tail.  (not it's = it is) 
Your/you're   If Brad comes along, you're going to be sorry (you are). 
 Were/we're   I don't understand why we're moving.  (we're = we are) 

 
 
VERBS: ACTIVE AND PASSIVE VOICE [3.18] 
Active Voice 

Instructors often tell students to write in the active voice.  What does this mean?  Active voice emphasizes 
a subject doing something, as in the following sentence: 

 Captain Hawes fired the gun.  
 I made a mistake. 
 
Passive Voice 

By contrast, passive voice emphasizes something done to a subject. 

 The gun was fired.  
 A mistake was made. 

Passive voice emphasizes a different subject: in the examples above, passive voice places the focus on 
gun and mistake, while active voice places the focus on who fired the gun and who made the mistake.  
 
Passive voice can also leave out important information—who did the action—contributing to vagueness 
and evasiveness. 
 
Active or Passive Voice?    

In general, use the active voice because it is usually more direct, provides more information, and reduces 
wordiness. Passive voice often requires more words than active voice to express an idea, thus contributing 
to the problem of wordiness.  
 
 Active:       Captain Hawes fired the gun.  
 Passive:    The gun was fired by Captain Hawes. 

 Active:       The President made a mistake.  
 Passive:    A mistake was made by the President. 

However, use the passive voice when you want to emphasize the receiver rather than the doer of the 
action: 
 

Passive:     Tetracycline was increased to 50 mg.                   
Active:        Researchers increased tetracycline to 50 mg. 

 
Passive:     Students in Klein's (2003) study were paid $25 to participate.                   
Active:        Klein (2003) paid students $25 to participate in the study.                   

 
Use passive voice to avoid awkward and vague pronouns (like the pronouns you and we , when they don't 
refer to identified individuals):  

Active:        You can use fewer words, but you will lose important information. 
Passive:     Fewer words can be used, but important information will be lost. 

In this example, passive voice is a way to de-emphasize the vague subject, you, and place the emphasis 
on what is done 
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VERBS: TENSE FOR REPORTING RESEARCH [318, p. 78] 
Research is always reported in the past tense. (Tense is the grammatical term for time.) Whatever was 
said, done, written, etc. was done earlier and is not still being done.  Note the earlier examples and their 
past tense verbs.  Here are some past tense verbs used for writing about research.  These words have 
different meanings, so select carefully for your context: 
 

accepted accounted for advised  advocated affirmed 

agreed  analyzed  asserted  claimed  commented  

concurred considered  contradicted  countered  declared  

defended demonstrated denied  described  disavowed  

disclaimed  discovered  disputed  dissented  emphasized 

established examined  explained  explored  expressed  

implied  indicated  informed  inquired  investigated  

maintained mentioned  noted  observed  offered  

posited  presented  probed  promoted proposed  

questioned  recognized  recorded  recounted  refuted  

rejected  related  remarked  reported  repudiated  

revealed  stated  studied  suggested  summarized  

supported surveyed  theorized  urged  

 
Although research is reported in the past tense (because the research was done in the past), sometimes 
present tense is needed to express general truths or facts that exist in the present.  Consider the following 
example: 

Galileo claimed that the earth revolves the sun. 
 

The asserting took place in the past, but the earth is still revolving around the sun.  
 
 
WORDINESS: Eliminate It [3.08]  
Wordiness refers to the habit of loading one’s writing with words that don’t contribute to the meaning.  Why 
do peopledo it?  Sometimes because they’ve been assigned a 500-word paper, but have only 200 words of 
ideas about the topic; so they toss in extra words, adding quantity withoug quality. 

Other writers use extra words to obscure thier undeveloped thinking.  When they’re not sure what they’re 
talking about, they try to cover it with words.  Most readers, however, recognize the ploy.  Writers who rely 
on verbosity lose credibility with their readers. 

Some writers are wordy without realizing it.  They employ stock phrases without considering whether or not 
they add meaning to their sentences.  Below are some examples.  Wordiness is a problem that should be 
corrected when revising.   

The Western style of academic and business writing requires you to (a) state ideas directly and clearly, and 
(b) use as few words as possible to get the point across. 

Avoid  words that don’t add meaning: 

The fact of the matter is that I’m tired = I’m tired 

WORDY                                                           CONCISE 

at this point in time ------------------------------ now 
in this day and age ------------------------------- today 
yellow in color ----------------------------------- yellow 
In the month of November --------------------- in November 
an unexpected surprise -------------------------- a surprise 
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at that point in time ------------------------------ then 
due to the fact that -------------------------------- because 
end result ------------------------------------------- result 
past history----------------------------------------- history  
He is a person who can be trusted ------------ He can be trusted. 
in order to ------------------------------------------ to 
the field of computer science ------------------ computer science  
There are many teens who smoke. ------------ Many teens smoke. 
two different kinds ------------------------------- two kinds 
refer back to --------------------------------------- refer to 
surrounded on all sides -------------------------- surrounded 
There is no doubt that he lost.------------------ No doubt he lost. 

 
Unless you know that you are a very succinct drafter, you should plan to cut your wordage by 20% in your 
first revision of each paper.  Read through your work and find places to cut repetitions and unnecessary 
wording.  The following is an excerpt from a paper written for a management course.   
 

 The employees were not in agreement with the change in operational procedures 

that the manager was wanting. Owing to the fact that they had much work to do, it was not 

easy for them to adapt to new changes. What they were trying to express was that they were 

dissatisfied, but there was a lot of resistance to their communication on the part of the 

manager.  It seems to me that the manager should have been able to work out some way to 

let the employees of her company be heard by her.  A manager who had good training 

would have had an idea about what to do. Personally, I don’t think that the manager in this 

company had been trained very well.  As far as my opinion, I would have to say the poor 

managers are the kind of people who don’t listen to what their employees are trying to say, 

whereas good managers try to find ways for the employees to express themselves and then 

try to respond to what the employees are saying. 
 

Now compare the paragraph to the following one, which has been revised for wordiness and redundancy: 
 

 The employees did not agree with the supervisor’s proposed procedural changes. 

Because they had heavy workloads, they could not easily adapt to change.  They tried to 

express their dissatisfaction, but the manager resisted communication.  The manager should 

have listened to her employees.  A well-trained manager would have known what to do.  

Poor managers don’t listen, whereas good managers listen and respond to their employees’ 

feedback.  

 
 

SUMMARY, RESPONSE, and CRITIQUE 

Definitions 
    Summary.  A condensed version of an original presentation that  

• identifies the original author by name,  
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• identifies the context for the original presentation, and  
• states the original author’s main idea and major points  

     Response.  Describes and explains your intellectual response to the original author’s presentation.  The 
response may include one or more of the following:  

• how the original author’s ideas compare to the ideas of other experts.  
• whether or not the original presentation contained logical flaws or misinformation. 
• whether or not the author responded to other points of view on the subject. 
• how the author’s ideas might be applied or how they might change a situation if they were (or 

were not) applied. 

Critique.  A combination of summary and response.  Summary precedes response in a critique. 

Tips For Writing Good Summaries 

• Put aside your own opinions when you begin to read the original, and do not let yourself mentally 
argue with the author as you read.  Remain objective in order to “hear” what the author is saying.   

• Start your reading with these questions, in this order: 
o What is the topic? 
o What opinion does the author most want readers to keep in mind about this topic? 
o What arguments or information does the author use to convince (or try to convince) 

readers? 

• Summarize as you read.  Write a sentence in your own words at the end of each paragraph.  Draw 
from these sentences for your final summary.   Put the text out of view to ensure that you are 
summarizing in your own words.  Check yourself. 

• Never insert your own ideas into a summary.   A summary contains only the ideas of the original 
author.  Period.  Your opinions are appropriate for the response or critique. 

• Formatting can give you hints about main ideas and supporting points. 

o The title can suggest a question and answer about the topic.   
o Headings and section breaks can give a clue to main topics. 
o Italics or boldface type usually indicate an important point. 
o Paragraph or sentence numbering can indicate important points. 
o The main idea of a paragraph is often (though not always) expressed in the first two or 

last two sentences of the paragraph. 
o The first paragraph often provides an overview of the entire article.  The last paragraph 

often provides a very brief summary. 

• Examples, illustrations, and anecdotes (little stories) are almost never main points.  When you run 
across an example, ask yourself:  Ok, what is this an example of?   

• Use the original author’s ideas, but not his or her words.  Instead, paraphrase the author.  
Paraphrase means that you read the author’s words, and, without referring to the text, write down 
the author’s idea in your own words. 

• Make sure you understand what you’re reading.  If you don’t, talk to someone—instructor, 
classmate, Writing Center consultant—until you are sure you do.  You can’t summarize what you 
don’t understand.   Get help: it’s not only allowed, it’s encouraged. 

Tips for Writing Good Responses  

• In academic or scholarly writing,  

1. responses are based on facts that you can support (facts from experts, class 
discussions, assigned reading in your text, and the like), not on hearsay or emotions 

2. responses are based on the original author’s purpose and audience. 
3. you must provide support for the opinions you express in your response. 
4. your opinions and interpretations appear only in your response, not in your summary of 

the author's work. 

• Sometimes an instructor will ask you for a gut reaction or a reaction based on your own 
experience.   In that case, and only in that case, you may stray from Point 4 above.  Still, you 
should try to analyze your reaction so that you can state why you responded as you did.   
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Tips for Writing Good Critiques 

The most frequent mistake students make when asked to critique an article is to tell the instructor only what 
the article is about.  A critique requires that you articulate your opinions about the article.  If your instructor 
does not provide guidelines for writing a critique, follow these: 

• Identify the author, his or her affiliation, and the context for the article or presentation. 

• In one to three paragraphs, summarize the article: Describe the purpose and focus, and identify 
the major points of the article.   

• If the work being critiqued is a research study, describe the type of research, including purpose 
and methodology.   

• Comment on the author’s assumptions, methods, and conclusions.   What was the author trying to 
accomplish?  Did the author acknowledge and respond to other points of view?   How objective 
was he or she?  What new ideas were presented?  How do the author’s ideas compare with 
prevailing views on the topic?  What strengths or weaknesses did you notice in the author’s 
methods and reporting?   

• Comment on the author’s work in terms of your own knowledge and experiences with the topic.  If 
you came away with new insights, explain them.  If you disagree with the author, say why; but 
explain your views as they derive from knowledge and objective experience, not from feelings or 
intuition. 

• Describe how you can apply what you learned from the article.  If you reject its application, explain 
why.  How could others in your profession apply this information? 

• Provide a complete reference for the article in APA style. 

NOTE:  Special instructions from your instructor always take precedence over this guideline. 
 
For more tips on writing critiques, with examples, go to www.smumn.edu/tcwrite 

FORMULATE A RESEARCH QUESTION AND THESIS  
Once you have selected a topic, you might think you are ready to search for information—but hold on a 
minute!  Ask yourself, what do I want to know about this topic?  If it’s a topic you are familiar with, ask 
yourself, what is the most important point to make about this topic?  Such questions give you motivation 
and focus, and they help you stay on track.  You’ll know what you’re looking for: the answer to your 
questions.   

An outline or overview—a roadmap, if you will—is very helpful at this point.  You need to know where you 
are going, how to get there, and when you have arrived.  If necessary, or if you desire, you can revise the 
outline and the research question as you proceed.    

Your answer to the major research question is the thesis of your paper.  Have you ever read something, 
and afterwards found yourself asking, so . . . what’s the point?  If there is no point, it’s because the essay, 
research paper, or editorial does not have a thesis—or at least not a clear one.  

Sometimes you won’t refine your own thesis until you’ve completed your research.  However, you’ll never 
find the thesis without a research question. 

 
WRITE AN ABSTRACT [2.04] 
Abstracts can vary according to the purpose of the document and the instructor’s or publisher’s 
preferences.  The following points, however, are useful general guidelines.  For additional information, 
including styles for empirical studies, reviews or theoretical articles, methodological papers, or case 
studies, see Section 1.07 of the Publication Manual of the American Psychological Association, 5th edition. 

Length  

An abstract is less than one page, double-spaced.  It is generally one paragraph ranging in length from 
75 to 120 words. 

Tips for Contents 

http://www.smumn.edu/tcwrite
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 Write a comprehensive summary of the article, including conclusions. 

 Indicate the purpose and scope of the information contained in the article. 

 Describe the kinds of sources used (professional literature, observation, interview, etc.) or methods 
or procedures, depending upon type of article. 

 State conclusions, implications, and applications. 

 Use key words used in the article that will enable database searchers (a) to discover your work in a 
keyword search and (b) to decide whether your article is pertinent to their needs. 

 Mention nothing in the abstract that is not included in the article. 

 Be focused: Use specific nouns (e.g., elementary science teachers, not educators) and active verbs. 

 Be objective: Summarize, but don’t evaluate or editorialize. 

 Be concise; every word must count. 

Tips for Being Concise 

   Do not repeat the title in the abstract. 

   Avoid citing sources if possible. 

   Use numerals (e.g. 32) rather than words (thirty-two). 

   Start with the most important statement about the article. 

   Include only the most important findings. 

   Do not include examples. 

   Avoid passive voice (e.g., not similar results were reported by three researchers . . . , but three 
researchers reported similar results). 

   Avoid starting sentences with “it is” and “there are” (e.g., not There were four studies that showed 
. . . , but Four studies showed). 

   Avoid meaningless phrases like This review was undertaken to compare x and y (instead of This 
review compares x and y) 

APA Formatting 

   The abstract follows title page and is numbered as page 2. 

   Type the word Abstract one inch from top margin, centered, no italics or bold, only first letter capitalized (Style 
1 heading). 

   Double-space throughout, including after title line. 

   Use same font as body of article. 

 

Other APA Rules for Abstracts 

   Avoid abbreviations if possible, but define them if used. 

   Do not use quotes; if citation is necessary, use brief the form (author, pub date). 

   Use third person (he, she, it, they) but not first (I, we) or second (you). 
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PART THREE: USING MICROSOFT WORD 2007® FOR APA TASKS 
For Word 1997-2003 instructions, go to www.smumn.edu/tcwrite, and look under "APA for Grad Students." 

 
 

 
GET TO KNOW THE RIBBON BAR—THE "DASHBOARD" OF WORD® 2007  
 
 

 
 
 
  

 
 

QUICK ACCESS TOOLBAR 
(can be customized) 

RIBBON BAR TABS  
(There are  7 of them: from the left, Home, Insert, Page Layout, References, Mailings, Review, View) 

OFFICE ICON  
opens a menu 

RULER BAR can be turned on/off with icon above 
the scroll bar or by clicking Ruler in the View Tab 

RIBBON 
BAR 

RIBBON 
BAR 

http://www.smumn.edu/tcwrite
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MS WORD®  2007, GENERAL TIPS 
The diagram above is to assist you with terminology in this section.  For more word processing information, 
the University Library has Word 2007 manuals for student use.  The Writing Center also offers assistance.  
Beginners should enroll in a word processing course or workshop. 

The feature that most distinguishes MS Word 2007 from earlier versions of Word is the Ribbon Bar.  The 
Ribbon Bar is loaded with features, many of which you will never use, but the features cannot be changed or 
customized.    However, Word 2007 also has a Quick Access Toolbar that can be customized and moved 
to a more convenient location. 

The directions throughout this booklet are based upon use of the Ribbon Bar because that is what all Word 
2007 users have in common.  In a special section of this book, however, you will find directions for 
customizing and using the Quick Access Toolbar, which can make your work faster and easier.  Refer to the 
table of contents at the beginning of the booklet. 
 
 
Backspace and Delete 
The keyboard has two delete keys: Backspace and Delete.  What’s the difference? 

 The Backspace key deletes characters and spaces to the left of the cursor (see the arrow pointing to 
the left?). 

 The Delete key deletes characters and spaces to the right of the cursor . 
 

 
 
 
 
              
 
 

Dashes and Hyphens 

 Hyphens are used to connect words and parts of words.  The hyphen key is located next to the 0 on the 
keyboard. Type hyphens with no space before or after (for example, "a rags-to-riches story" ). 

 Dashes are intended to separate words and phrases.  To create a dash, type two hyphens with no 
space before, after, or between them.  Use dashes to indicate an interruption (e.g., "Students in Group 
2—those who received no training—were least successful at accomplishing the task.") 

 
Center Never center text by tabbing or spacing.  If you do, any revisions will throw the text off 
center.  Use the Centering function of the word processor. It will automatically adjust centering as 
you revise.  You can center text before or after it is typed.  If you center after typing, you’ll need to 
highlight the text, then center it.  To center text, 

 
Click the Centering icon            (on the Ribbon Bar's Home tab, Paragraph section)  

 
 
 
 

 
 

 

 

 

  

For example, in the sentence below—where the cursor has been placed 
after the n in frustration—pressing the Backspace key twice will erase the n 
and the o, whereas pressing the Delete key twice will erase the space and 
the b. 
 
 Save yourself some time and frustration by using the keys correctly. 

(General Tips) 
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Grammar Check 
A word of caution about grammar check . . . 

The grammar checker can be a useful tool, but it cannot think the way a human does. If you type something 
that doesn't fit one of the grammatical patterns stored in the grammar checker's memory, it will give you an 
"alert," meaning it can't find a matching pattern.  Think of the alert as a question rather than a command.  It 
is asking, Is this the pattern you really want?  For example, the grammar check usually alerts writers to use 
of the passive voice,* because passive voice is usually best avoided.  However, it is not necessarily wrong, 
and on occasion it may even be preferred to active voice.  You must decide to keep, discard, or modify text 
that sets off the grammar alert.  Don't change something just because the grammar check highlighted it.   

*Passive voice is explained in the Writing Center's Introduction to the APA and Other Writing Tips and in the 
APA manual. 

 

APA References and Word 2007  
The 4th tab on the Word 2007 Ribbon Bar is References.  If you click on it, you will see a listing for APA 
style.  Alas, the style is not correct.  Word 2007 does not (1) format titles, volumes, or issues correctly; (2) 
does not space lines correctly; and (3) does not create hanging indents.  Aside from those shortcomings, 
you may find Word's References useful.  Just be sure to make the corrections after you use it.  Throughout 
this booklet you will find other ways Word 2007 can make APA formatting much easier. 
 

Page Breaks     ….Page Break… 

Generally, the word processor automatically creates page breaks as your typing spills over from one page to 
another.  However, at times you need to force a page break: for example, at the end of the title page or 
abstract, or before starting the reference page.   

Do not force a page break by pressing the Enter key repeatedly.  This will cause text to move down the 
page every time you revise, leading to unsightly gaps between sections. 

Instead, use the following shortcut key: Ctrl+Enter. (Hold down the Control key while you press Enter). 

To view the page breaks you have entered, see Show/Hide in the section below. 
 
Show/Hide  

 
The Show/Hide function allows you to see hidden formatting codes—a helpful tool when you need to correct 
or modify formatting.  To find the Show/Hide icon, 

1. On the Ribbon Bar, click the Home tab. 
2. In the Paragraph section of the Home tab, find the Show/Hide icon: 
3. The Show/Hide icon is a toggle switch: Click once to turn it on, and click again to turn it off. 

 

 

 
  
 
 

 
 
  
  
 

(continued) 
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The Show/Hide icon            reveals the following codes: 
 
 

 

 

 
 
 

 
 

 

● SHORTCUT ● SHORTCUT ● SHORTCUT ● SHORTCUT ● 

The Show/Hide icon also appears on the Quick Access toolbar, which is visible no matter what tab is 
open. 

 

 
 
 
 
 
 
 
 

Undo  
The Undo icon              is located on the Quick Access Toolbar (see diagram). Clicking the Undo icon allows 
you to cancel your last command (if you click Undo once ) or your last several commands (if you click 
repeatedly).  Make a mistake?  Just click Undo!  

 
 

  
 

 
 
 

 
 

Remove Hyperlink  
When you type a URL (Internet or e-mail address) and press the Enter key, the URL turns blue and 
underlines, creating a hyperlink.  Hyperlinks occur on your Reference page when you type URLs for 
electronic sources.  Hyperlinks must be converted to “normal” text:  
 

1.  Right Click on the hyperlink (click the right mouse button)  
2.  When the menu opens, click Remove Hyperlink. 

 
 
 
URLs (Internet addresses) appear on your reference page but should never be inserted as in in-text 
citations.  
 
 
  

SYMBOL MEANING 

 
 

Manual line feed 
(Enter key pressed) 

 
 Tab space entered 

 
 Spaces inserted (1 dot =  1 space) 

 Manual page break inserted 
(Ctrl+Enter) 
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INITIAL SETUP OF APA PAPERS 
 
 

Get started off right!  Set up APA format before you begin typing.  You can set formatting for your current 
APA paper only, or you can change the default so that the formatting stays set for future APA papers.  (You 
can set the default back to MS Word's original settings at any time.)  As you become more familiar with 
Word 2007 for APA, you will find shortcuts for some of the tasks described in this section.  The directions 
below allow the option of changing your default settings so you won't have to keep reformatting 
each time you start an APA 
 
FONT (TYPEFACE) 

The standard for APA (p. 212) and for  student papers at Saint Mary's University is Times New Roman 12.  
Boldface and underline are never used in APA papers, but italics is used for some headings.  Setting the 
typeface for a single paper is easy.  Simply select the font and font size on the Home tab of the Ribbon bar. 

 
 
 
 
 
 
 
 

  

 
FONT (Typeface) 

To change the default setting for all 
papers,  

1. In the Font section of the Home tab, 
click the arrow in the right corner to 
open the Font Menu. 

2. In the Font menu select settings for 
a. Times New Roman 
b. Regular 
c. 12 

3. Click the Default… button at the 
lower left. 

4. When prompted by the menu, click 
Yes to reset the default setting. 

5. Click OK to close. 
 

1 

2c 

3 

2a 2b 

4 
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MARGINS 

Margins must be set from the Page Setup section of the Page Layout tab.  Do not try to set margins from 
the Paragraph Setup section.  Margins show be set at 1" on all four sides (except for doctoral students, 
who use 1.5" on the left side).  
 
  

 

 
MARGINS 

 
To set margins and change default, 

1. On the Ribbon Bar, click the 
Page Layout tab. 

2. In the Page Setup section of the 
Page Layout tab, click the arrow 
in the right corner. 

3. When the Page Setup window 
opens, select the Margins tab if 
not already open.  

4. Make sure all four margins are 
set at 1 inch.  

5. To make this the setting for all 
papers, change the default 
setting as follows: 

a. Click the Default . . . button at 
bottom left. 

b. When the next window 
opens, click Yes. 

 
 
*Doctoral students use a left 
margin of 1.5" 

1 

2 

3 

4 

5 

6 
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TEXT ALIGNMENT, INDENTS, AND LINE SPACING 

Perform settings before typing. 
  

2 

3 

4 

5 

6 
7 

8 9 

TEXT ALIGNMENT set at LEFT 
1. On the Ribbon Bar, click the Home tab. 

2. In the Paragraph section of the Home tab, 
click the arrow in the right corner. 

3. When the Paragraph window opens, click the 
Indents and Spacing tab if not already open. 

4. Set alignment to Left as illustrated. 

All APA text is aligned to the left margin, 
except for centered headings and title page, 
where the Center command is used.  Do not 
set alignment at "justified" to make the right 
margin even.  The right margin should be 
ragged. 

INDENTATION set at 0 and NONE 

5. All indentation 0 and "(none)" should appear 
in the box as shown at left. To indent the start 
of a new paragraph, use the  Tab key . 

LINE SPACING is DOUBLE THROUGHOUT 

6.  In APA lines are double-spaced throughout—
never more, never less (except on some title 
pages). 

7. If you find irregular spacing between 
paragraphs (usually an extra line), it is 
because the "Before" and "After" spacings 
are not set at 0  as shown at left 

SAVE SETTINGS (Change Default) 
8. To save settings for current paper only, click 

OK. 

9.  To save settings for future papers, change 
the default setting as follows: 

a. Click the Default . . . button at bottom left. 
b. When the next window opens, click Yes. 

Hanging Indents for references and indented 
block quotes are explained elsewhere in this 
booklet . 
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PAGE NUMBERS AND PAGE HEADERS      [p. 230] 
The APA manual calls for a page number and a running head, both inserted into the header box, ½-inch 
from the top edge of each page, including the title page..  and page headers on every page, including the 
title page.  Check to see if your program requires a different arrangement. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

To insert page numbers and running head into the header . . .  

1. On the Ribbon Bar, click the Insert tab . 

2.  In the Header & Footer section of the Insert tab, click the Page Number Icon. 

3.  When menu opens, click arrow for Top of Page selection. 

4. In the new menu (not shown in diagram), click the illustration showing page 
number at top right of page. 

5. Page number will insert automatically in the header box and will keep the header 
box open so that you can type your running head inside it. 

 A running head is just a short form of the title appearing on every page so that if 
pages get separated from the document, they can be identified for reinsertion. 

 
 
 
 
 
 
 
 
6. After page number is inserted, type the running head in front  it , with no 

space between running head and page number. 

Running head: TYPE IN CAPITALS 
Make sure header and page number are set to Times New Roman 12 to 
match font of paper.  

7. With the cursor between the running head and the page number, press 
the Tab key as many times as needed to align the running head at the left 
margin and the page number at the right margin. 

8. To exit the header box, double click anywhere outside it.  Page numbers 
and running head will appear on every page.  Page numbers adjust as 
you revise. 

 

 

 
 

2 

3 

1 

Header box. 
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Keep Page Number and Header off First Page     
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

 
 
 
 
 
 

 

 

 

 
INDENTATION: HANGING INDENTS AND BLOCKED QUOTES 

 
Hanging Indents 

Do not create hanging indents "manually" by inserting line breaks and tabs or spaces.  If you do, you will not 
be able to revise your reference page.  Instead, follow the directions below to allow MS Word to insert 
automatic hanging indents that self-adjust as you revise. 
You can set hanging indents before or after typing the text.  If you format hanging indents after typing the 
text, you’ll need to highlight the text before formatting.  You will also need to remove all Tabs, if you inserted 
any, from the Reference list. (See Show/Hide in this section.)  

Instructions for creating hanging indents are as follows:  
 

(continued)  

 

2 

 
To keep page number and header off title page (if instructor requests),  

7. Insert page number and header as described above. 
8. On the Ribbon Bar select the Page Layout tab. 
9. In the Page Setup section of the Page Layout table, click the arrow in the right corner. 
10. When the Page Setup menu appears, select Layout tab. 
11. Click the Different first page tab to insert a check.  
12. Click OK at the bottom of the Page Setup box to close and return to document 
 

2 

4 

5 

3 

 
To keep page number and header off title page (if instructor requests),  

1. Insert page number and header as described above. 
2. On the Ribbon Bar select the Page Layout tab. 
3. In the Page Setup section of the Page Layout table, click the arrow in the right corner. 
4. When the Page Setup menu appears, select Layout tab. 
5. Click the Different first page tab to insert a check.  
6. Click OK at the bottom of the Page Setup box to close and return to document 
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Hanging Indents 

  
To set hanging indents before typing the first reference entry , 

1.   On the Ribbon Bar, click the Home tab. 
2.   In the Paragraph section of the Home tab, click the arrow in the right corner. 
3.   When the Paragraph  setting box opens, click the arrow next to "Special:" 
4.   Select Hanging .  The settings will look like this: 

                            Special:            By:  
 
 

5.   Click OK to close.  

When you type reference entries, just allow the lines to wrap and indent automatically.  
Don't press the Enter button until you are ready to type the next entry 

 

 Hanging  0.5" 

1 

2 

3 

4 

5 
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Indenting Blocked Quotes 

Note: Use direct quotes sparingly, if at all.  Quotes of 40 words or more must be "blocked" rather than 
placed in quotation marks (see APA pp. 118-119) 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Ruler Bar   
  

Ruler Bar  If you don't see the Ruler Bar on your screen, you need to turn in on.  Look at the far 
right of the screen, just at the top of the Scroll Bar, to find the very small Ruler Bar icon.   Click 
the icon once to turn on the Ruler Bar. 

To create a blocked quote,  

1.   Type the quote, double-spaced. 
2.   Highlight the quoted text. 
3.   Locate the Left Indent on the Ruler Bar (right diagram). 
4. Drag the little box beneath the two triangles to the ½ mark (see diagram at right  and the 

Ribbon Bar section of this booklet). 
5. Release the mouse button 

2 

3 
4 

 Drag Square (or both triangles) ½" to right. 
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LISTS:  BULLETED OR NUMBERED  
Use numbers when the order of the items is important—for example, in presenting a set of ordered steps in 
a process.  Use bullets  when the order of items is not a factor.   

• Numbers and bullets should be ½ inch from the left margin, in line with paragraph indents.  

• Use lists to summarize.  They should not replace a detailed explanation or commentary. 

• Items in lists must be grammatically parallel.   

• Lists are double-spaced like the rest of the text. 

 
  

Bulleted or Numbered Lists 

1. Type the list (without 
bullets) and highlight 
it. 

2. On the Home tab of 
the Ribbon Bar, click  
the Bullets icon (while 
list is highlighted). 

3. On the Ruler Bar 
(while the list is still 
highlighted), slide the 
top triangle to ½" and 
the bottom triangle 
two notches to the 
right, as illustrated.  

4. Click the bullet icon 
again to turn off the 
bullets. 

Format numbers the same 
way as bullets.  The 
number icon is just to the 
right of the bullet icon. 

2 

3 
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WORD COUNT 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

ALPHABETIZE 
  

To count words quickly, 

1. Highlight the text containing the words you want counted. 
2. Look near the bottom left of your screen.  You will see a ratio: on the left is the number 

of words you highlighted; on the right is  the number of words in the entire document . 
 

To alphabetize quickly,  

1. Remove any extra blank lines after the last entry. 
2. Highlight the reference list (but not the title). 
3. On the Ribbon Bar, click the Home tab.  
4. In the Paragraph section of the Home tab, find  and click the "sort" icon:  
5. When the sort menu opens, make sure settings are as follows: 

Paragraph . . . text . . . ascending 
6. Click OK. 

 

3 

5 

4 
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"ORPHAN" HEADINGS  (For an explanation of APA heading styles and formatting, see the Writing 
Center's Introduction to the APA and Other Writing Tips as well as the APA manual, pp. 111-115.) 

Headings that  stand alone on a line can get separated from their text when they occur at the bottom of a 
page.  (Turning on widow/orphan control won't help with headings.)  The following procedure will ensure that 
headings remain with the text that follows them. 

NOTE: Do not use this command with APA style 4 indented headings.  Use it only for headings that 
appears alone on a line.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

To prevent heading from separating the their text . . .  

1. Place the cursor in front of the first letter of the heading (or before you type the heading). 
2. On the Ribbon Bar, click either the Home tab or the Page Layout tab. 
3. In the Paragraph section of the Home tab or Page Layout tab, click the arrow in the right corner. 
4. When the Paragraph  menu opens, click the Line and Page Breaks tab. 
5. Click to place  a check in the Keep with next box. 
6. Click OK. 

 

● SHORTCUT ● SHORTCUT ● SHORTCUT ● SHORTCUT ● 
To avoid repeating the steps above every time you type a title, you can place an icon on 
the Quick Access toolbar that  completes the steps with a click of a button.  See the 
section called "Customizing the Quick Access Toolbar." 

1 

2 

3 

4 

5 

6 
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CUSTOMIZE AUTOFORMAT SETTINGS   
Word 2007 is installed with auto-format settings that may be inconvenient for APA papers.  You can easily 
change these settings.  Customizing for APA or for any auto-format that suits you.  Autoformat changes will 
be maintained for all documents until you change Autoformat again. 

For example, many people are annoyed by "check-spelling-as-you-type" and "check-grammar-as-you-type" 
auto-format settings, which place red and green underlines on the screen to indicate possible errors. 

You can turn off those as-you-type settings and select Spelling and Grammar from the Review tab when you 
are ready to check. 
  

(Autoformat Settings) 

To change an auto-format setting,  

1. Click the Office Icon at the far top left of the screen . 
2. When the Office menu opens, click Word Options at the bottom of that menu. 
3. When the Word Options menu opens, click the Proofing button on the menu at left. 
4. When the menu opens, click off the boxes for Check-spelling-as- you-type and for Mark-

grammar- errors-as-you -type. 
5. Click OK to close. 

Other AutoCorrect options are available from the same menu (see "AutoCorrect Options…" button 
near top of menu) 

1 

4 

3 

2 
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DOT LEADERS FOR TABLE OF CONTENTS 
What Are Dot Leaders?  
APA provides no guidelines for a table of contents; however, some instructors do one.  Generally a table of 
contents calls for dot leaders—rows of dots from entries to their page numbers, like this:  

Statement of the Problem ....................................................................................... 3 
Research Questions ............................................................................................... 4 
Definition of Terms ................................................................................................. 5 
History of the Charter School Movement ................................................................ 9 

You will never make your page numbers line up, and you will wear yourself out typing dots if you don't set up 
dot leaders for your tab stops.  Dot leaders automatically insert dots when you press the tab key, and the 
dots adjust automatically to proportioned characters, giving you a straight column on the right.   

The first step for creating a table of contents is to type  the Table of Contents heading, centered, at the top 
of your page.  Next, double space and return cursor to left margin.  Then follow the procedure below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
NOTE: By setting dot leaders, you have turned the Tab key into a dot leader command.  You cannot 
now use the tab key to indent subheadings in the table of contents.   
If your table of contents requires indented subheadings, continue to the next page. 
  

 

1 

2 

3 

4 

 
Open the Tabs menu as 
follows: 

1. On the Ribbon Bar, 
click the Home tab. 

2.  In the Paragraph 
section of the Home 
tab, click the arrow in 
the right corner. 

3.  When the Paragraph  
setting box opens, click 
the Indents and 
Spacing tab. 

4. At the bottom left of the 
menu, click Tabs… to 
open the Tabs menu. 
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                 Parts of the "Hourglass" 
Drag upper triangle to indent first line of paragraph. 
Drag lower triangle to indent subsequent lines of 
paragraph. 

Drag square to move both triangles.  To indent a 
block of text, highlight the text and drag the square. 
 

To indent with the toolbar, 

1. Place the cursor where you want to begin the indent. 
2. Drag the indenting "hourglass" on the Ribbon Bar to the appropriate ½ " marker.   

Note that the "hourglass" is divided into 3 sections that can be dragged separately.  Refer to the 
drawing at right to select  the appropriate segment of the "hourglass" to drag. 
 
 

Indent Subheadings in the Table of Contents 
If your table of contents contains subheadings, you cannot indent them with the Tab key, which now inserts 
dot leaders.   
The only way to indent subheadings without dot leaders is to use the Ruler Bar to drag subheading into 
place. 

Statement of the Problem ....................................................................................... 3 
Research Questions ............................................................................................... 4 
Definition of Terms .................................................................................................. 5 
History of the Charter School Movement ................................................................ 9 

Urban Changes ........................................................................................ 10 
Inner City Crises ....................................................................................... 12 
Private Initiatives ...................................................................................... 13 
Legislation ................................................................................................ 15 

 
 
 

About the Ruler Bar . . .   
The ruler bars runs the width of the editing screen and is located beneath the Ribbon Bar. 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Indenting With the Ruler Bar  
 
 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 

 

(Table of Contents: Indenting)  
 

Use the Ruler Bar, not the Tab key to indent subheadings in the table of contents. 

If the Ruler Bar is not showing on your screen, turn it on as follows: 

1. On the Ribbon Bar,  click the View tab. 

2. In the Show/Hide section of the View tab, click inside the Ruler Bar box. 

3. An alternative way to turn the Ruler Bar on and off is to click the icon on the far right of the Ruler 
Bar. 

 

1 

2 

Grey areas of Ruler Bar indicate document margins 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

RULER BAR 
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CUSTOMIZING THE QUICK ACCESS TOOLBAR 

 
The Ribbon Bar in Word 2007 cannot be changed;  however,  Word 2007 does allow customizing of the 
Quick Access Toolbar. In its default setting the Quick Access Toolbar is located above the Ribbon bar and 
contains only a few icons: 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
Useful Quick Access Icons for APA Writers 
 

 
 
 

(Continued) 
 
 
 
 

  
Opens a new blank document without closing current document. 

 
 

 
Allows you to browse for and open an existing document in your 
folders. 

 
 

 
Saves the current document under its existing filename and location 

 
 

 
Saves the current document but allow for change of filename or 
location 

 
 

 
Prints document and allows for printer selections 

 
 

 
Prevents separation of the heading from the text that follows it 

 
 

 
Runs the spell check 

 
 

 
Searches for a character, text, or formatting command in current 
document 

Default Quick Access Toolbar 
 

Toolbar Customize Menu 
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5 

8 

3 

4 

To add a command icon to the Quick Access Toolbar, 

 1.  Click on the arrow to the right of the Quick Access Toolbar to open the Customize menu (see 
illustration previous page).  

2.  On the Customize  menu, click More Commands . . .  (see previous page). 

3.  When the Word Options menu opens (see below) select All Commands. 

4.  Make a selection from the menu and click the Add>> button . 

5.  Use the arrow buttons to move the command to the desired position on the toolbar list. 

6.  Repeat Steps 4 and 5 as necessary. 

7.  Select the "For all documents (default)" option. 

8. Click OK to close.  
 

 You can add any icon that makes word processing easier for you.  Even if the icon already exists on the 
Ribbon Bar, you may find it more efficient to use it on the Quick Access Toolbar.  Customize it in a way that 
works for you.  It's easy to remove an icon from the Quick Access Toolbar: just right click on it and select 
"Remove." 
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Remove a Command Icon from the Quick Access Toolbar 
1. On the toolbar, right click on the toolbar icon.  
2. Select Remove from the Quick Access Toolbar 
 
 
 
CORRECT IRREGULAR LINE SPACING 
 

Problem 
Cutting and pasting between documents can upset the line spacing of your document, sometimes leaving 
three lines rather than two between paragraphs, as shown in the example.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

 
Remedy 
The extra line space cannot be removed by 
changing the line spacing to double.  Instead, 
change the setting as follows:  

1.  Highlight the text you want to change. 

2.  From the Home Tab of the Ribbon Bar, 
open the Paragraph box. 

3.  Set the Before and After boxes to 0.  
     (Line Spacing should already be set at 

Double. 

4.  Click OK to return to document.  You may 
need to readjust spacing.  

 

3 

2 

1 
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TWIN CITIES CAMPUS WRITING CENTER 
SERVICES 

On-Campus  

 Writing Consultations.   
 On campus.  A writing consultant will read your paper, respond to it, and discuss its 

strengths and weaknesses with you.  (Please bring your instructor's guidelines for the 
assignment, along with the style manual designated for the class.) 

 Online. Submit your questions by e-mail.  You can submit a paper (or selected portions) 
as an e-mail attachment along with your specific questions about the paper.  You will 
receive a response by e-mail, or you can call our toll-free number 1-866-437-2788, ext. 
154, to discuss your questions. 

 Questions.  We will be happy to answer questions about APA, AMA, grammar, punctuation, or 
usage. 

 Word Processing Instruction.   Microsoft Word 2000® for Windows XP® 

 ESL Coaching.   Students whose native language is not English can develop their English writing 
and speaking skills. 

 SSVC100 Workshop: Introduction to APA Style for Graduate Students 
This interactive workshop introduces students to the APA, with an emphasis on locating information 
in the manual, recognizing rule patterns, and understanding purposes. Students will learn to create 
reference lists and basic in-text citations. In addition, students will be introduced to Microsoft Word 
® functions  that support APA-style formatting and will learn to create customized APA toolbars for 
their computers. Students are invited to submit electronic copies of their practice pages after the 
workshop for instructor feedback. 

The workshop fee is $50. Register online. Students who have questions should contact the 
Writing Center, 612-725-5154 or tcwrite@smumn.edu.  The workshop is offered on the Twin 
Cities campus three times each term.   

 Online Writing Center:  www.smumn.edu/tcwrite 

 Links to some of the best university writing centers in the nation 
 Links to information about various forms of academic writing  
 ESL Information.   Students whose native language is not English will find links to “English 

as a Second Language” resources. 
 Guide to avoiding plagiarism 
 Guide to quoting and paraphrasing 
 Guide to evaluating research sources 
 

POLICIES: WHAT WE DO and DON'T  
Writing Center consultations are free. 

 We help you become a better writer.  We won’t fix your paper for you; but we'll help you improve it 
and, in the process, help you develop as a writer. 

 You can have one appointment per week for up to 1 hour per week.  You can have up to two visits 
per paper. 

 We don’t edit. The Writing Center performs an instructional service, not an editing service.  Editing 
focuses attention on the paper rather than the writer.  Editing is often equated with proofreading—
that is, finding and fixing all the “errors” in the paper.  At the Writing Center, you will participate fully 
by setting your own writing objectives, discussing feedback, and revising your paper. 

 Sessions are confidential.  We do not share information with instructors without your permission. 
  

 
To make an appointment call 612-728-5154 (toll free 1-866-437-2788, ext. 154) 

or e-mail tcwrite@smumn.edu 
We are located in LaSalle Hall 128 (just across from the library) 
Hours are posted on our Web site: www.smumn.edu/tcwrite 
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Apostrophes, guidelines, 33 
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personal communication, 18 
primary & secondary sources, 16 
purpose, 16 
varying the wording, 18 
where & when to cite, 17 

Citing sources 
Four elements of an entry, 8 
Where to cite?, 8 
Why cite?, 7 

Colon, 21 
Comma, 21 
Critique, how to write, 43 
Customize 

Autoformat, 60 
Quick Access Toolbar, 63 

Dash, 23 
Default settings, 52 
DOI number, 11 
Dot leaders, 61 
Flow, how to improve it, 31 

audience awareness, 31 
consistency, 31 
headings, 23, 31 
organization, 32 
parallelism, 32, 34 
pronouns, 31, 35 
quotations, limit, 31 
quotes, limit, 4 
repetition, 32 
transitions, 31, 37 
verb tense, 33, 40 
wordiness, avoid, 32, 40 

Font, 2 
Format of an APA paper, 1 

alignment, 1, 52 
font (typeface), 2 
headings, 2 
indents, 2, 52, 54, 56, 62 
line spacing, 2, 52, 65 
margins, 2, 51 
page numbers, 2, 53, 54 
spacing after punctuation, 1 

Four elements of a reference entry, 8 
Grammar check, 48 
Hanging Indents, 54 
Headings, 2, 23, 59 

1-level example, 24 
2-level example, 25 
3-level example, 26 
4-level example, 27 
about, 23 
in the appendix, 28 

prevent orphans, 28, 59 
Hyperlink, turn off, 49 
Hyphen, 23 
I / we, 36 
Indents, 2, 52, 54, 56, 62 
Line Spacing, 2, 52, 65 
Lists (Seriation), 28 

bulleted, 28 
how to format in Word, 57 
lettered, 28 
numbered, 28 

Margins, 2, 51 
MS Word 2007 for APA, 45–65 

alignment, 52 
alphabetize, 58 
autoformat, customize, 60 
backspace & delete, 47 
center, 47 
customize 

autoformat, 60 
quick access toolbar, 63–65 

dashes & hyphens, 47 
general tips, 47 
grammar check, 48 
headings, prevent orphans, 59 
hyperlink, remove, 49 
indents, 52 

block quotes, 56 
hanging indents, 54 

irregular line spacing, correct, 65 
line spacing 

correct irregular, 65 
line spacing, 52 
margins, 51 
page breaks, 48 
page headers, 53 
page number 

keep off 1st page, 54 
page numbers, 53 
quick access toolbar, 63–65 
ribbon bar, 45 
ruler bar, 62 
show & hide, 48 
table of contents, 61 
undo, 49 
word count, 58 

Page breaks, 48 
Page numbers & headers, 2, 53, 54 

keep off title page, 54 
Parallelism, 34 
Paraphrases, 6–7 
Parentheses, 23 
Personal communication, 18 
Plagiarism, 4 
Primary & secondary sources, 15–16 
Pronouns, 35–34 

it, unspecified, 35 
this,that,these,those, 35 
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we, us, I, they, them, 36 
which,that,who, 35 
you, 36 

Punctuation, 20 
apostrophe, 20 
colon, 21 
comma, 21 
dash, 23 
hyphen, 23 
parentheses, 23 
quotation marks, 23 
semicolon, 23 
spacing with, 20 
with transitions & conjunctions, 36 

Quotation marks, 23 
Quotations, 4 

blocked, about, 5 
blocked, create in Word, 56 
capitalization in, 5 
effective use, 4 

Reference page, 8–16 
audiovisual materials examples, 13 

DVD, 13 
motion pictures, 13 

business & management databases, 12 
Datamonitor, 13 
EDGAR, 12 
Gale, 12 

doi number, 11 
electronic source examples, 11 
electronic sources, 10 

ERIC, 12 

periodical from database with doi, 11 
periodical from Internet, 10, 11 

four elements of a reference entry, 8 
legal documents, 10 
print source examples, 9 

book, 9 
book, publisher as author, 9 
chapter in a book, 9 
periodical, 2 authors, 10 

sample reference page, 14 
titles, formatting on the reference page, 18 

Research question, 43 
Scholarly source, 7 
Semicolon, 23 
Seriation. See Lists 
Spelling troublesome words, 37 
Summary, how to write, 42 
Table of contents, 61 

indent subheadings, 62 
Tense of verbs, 40 
Thesis, 43 
Title page, 2–3 
Titles 

capitalization in the text, 20 
capitalization on the reference page, 19 
in the text, 19 
on the reference page, 18, 19 

Transition words & phrases, 37 
Verb tense, 40 
Word Count, 58 
Wordiness, how to avoid, 40–41 
Writing Center services & policies, 66 
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